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Welcome to Above & Beyond

Above & Beyond is a powerful Personal Information Manager (PIM) for planning, 
managing, and tracking your active business and personal life.    Innovative dynamic
schedules manage workflow effectively.    All types of recurring activities need be 
entered just once.    You can print schedules to take your plans wherever you go.    
Above & Beyond also includes pop-up calendars, alarms, task and event timers, 
week and month at a glance, contact databases, project tracking, group scheduling,
E-mail, company-wide phonebooks, and much more.

Above & Beyond is for everyone who has a lot to do and wants to do it!

"If you use Windows and have any kind of schedule to manage, this is the program 
to get! I recommend it highly. "

- Michael Callahan, Editor, Shareware Magazine

The more you accomplish each day, the sooner you'll reach your goals, and the 
more successful you'll be. This is why we created Above & Beyond for you. 

The key to accomplishing more is planning ahead. You need a plan that allocates 
time for the things you want to do that will bring you the greatest return. The order 
and timing of tasks affect how quickly they can be accomplished. As your work is 
streamlined, your productivity will soar.

Dynamic Scheduling

Above & Beyond gives you the power to create personal schedules quickly and 
effectively. It automatically calculates timing, as you juggle the order of tasks by 
sliding them with your mouse. Want to defer something to another day? That's easy.
Just click the right mouse button on a day in the pop-up calendar.

Above & Beyond is the PIM for success.

There are many Personal Information Managers, but Above & Beyond is the only one
that makes it so easy to plan your time. Other PIMs consign your tasks to to-do lists,
separate from your schedule. This makes planning difficult. They'll let you convert a 
task into an appointment, but the begin time is fixed. Above & Beyond solves this 
problem brilliantly. Everything you want to do appears in one place, where you can 
arrange your plans quickly and easily. The time you plan to begin a task will float, 
automatically updating as your schedule changes.    Above & Beyond creates time 
for your tasks based on everything you're doing, in the order you've arranged. No 
other PIM can do this. Above & Beyond is the first PIM with Dynamic Scheduling.



Save Time & Money with Above & Beyond

Many Above & Beyond users who've switched from other PIMs are now saving 1 to 2
hours each day. The main reason is this: Above & Beyond creates and adjusts your 
plans so easily, that the schedules you work from are optimal, letting you 
accomplish hours of additional items each day in the same amount of time. 
Remember, the key to accomplishing more is planning ahead.

Putting Above & Beyond to use can save you an hour or more each day. In an 
average workday, that translates to a boost of 10-20%. Imagine your annual income
jumping 10-20%. With Above & Beyond you could realize a gain of $2,000, $5,000, 
or $10,000 per year.

Think of how this could benefit your entire department, or even your whole 
company. Imagine if you showed the CEO of your company Above & Beyond and it 
was adopted corporate-wide for everyone to use. If that's 10 or 10,000 people, you 
could be responsible for additional profits every year of between 100 thousand and 
100 million dollars.

Register Above & Beyond

We invite you to use the on-line help to learn all about Above & Beyond and start 
putting it to work for you.    When you're convinced it will save you substantial time 
and money, register.    The price per user is only $99.    For information on how to 
register, see Registration/Ordering a License.

For any questions, including special pricing for workgroup systems of five or more 
users, call us at (541) 822-6000 or fax to (541) 822-3300.    System prices are 
posted on our web-site at http://www.1Soft.com.
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Above & Beyond is developed and published by 1Soft Corporation.

"1Soft is serious about helping you get the most out of your time." 
- PC Magazine
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Comments from Users

The most important component of any PIM is its scheduling module... Above & 
Beyond is in a class by itself due to its automatic, or dynamic, scheduling. It's the 
only program that takes a unified approach to scheduling by letting you enter all 
events -- to-do list items and appointments -- on one calendar.

- Steve Gilliland and Kathy Yakal, PIM comparisons in PC Sources, July 1992

Above & Beyond is the most useful scheduling/todo/project management software I 
have ever used (tried all the rest...big bloated, glossy electronically simulated paper
systems).
Above & Beyond appears to have been developed to address a need; rather than to 
have a product to sell.

- Dwayne Hedrick

Above & Beyond is the best application Ive ever seen for real life, day-in-and-day-
out, pound-on-it-every-minute users.

- Clark Wilson

I have been comparing Above & Beyond against another product of similar nature. 
They just don't compare! My other program has proved to be nothing but trouble, 
missed appointments, compatibility problems, etc. Above & Beyond is exactly what 
I've been looking for and I am ecstatic about it.

- Len Zigante, President, Vantage Point Services, British Columbia 

My enthusiasm for Above & Beyond is unbounded. It's head and shoulders above 
any other PIM on the market.

- Lee S. Jones

Once you start using Above & Beyond, you'll wonder how you managed without it.
- Clive Aldred, PC User Magazine.

That dynamic scheduling is worth its weight in gold.
- Robert Puttcamp

Above & Beyond is the greatest and most valuable piece of business software I have
ever had.

- Hilary B. Miller, Esq.

Above & Beyond is an excellent program that's been carefully thought out. This is 
the handiest PIM I've ever used and I find it invaluable in keeping my schedule 
manageable. 

- Michael Callahan, Editor, Shareware Magazine

Above & Beyond is GREAT! A marvelous time-saver!
- Bob Haussmann

I have loved this software since day 1. 
- Ivan Druez





Companies Using Above & Beyond

The world's leading companies use Above & Beyond on LANs and personal 
workstations.

Hewlett-Packard, Intel, Martin Marietta, GTE, Kidder Peabody, Telecom Australia, Yale
University, Ziff-Davis, NASA, Allied-Signal Aerospace, AT&T Bell Labs, NCR, 
Goodyear, ABC News, Whirlpool, Arthur Andersen, American Airlines, Borland, 
Carnegie-Mellon University, CIGNA, Compaq, Discovery Channel, DuPont, Goldman 
Sachs, Honeywell, IBM, Lotus, Merrill Lynch, Union Bank of Switzerland, Volvo, 
Microsoft, Westin Hotels, AMD, Salomon Brothers, Seagate, Novell, Siemens, and 
thousands of others.



Above & Beyond is International

Registered Above & Beyond users hail from 33 nations around the world:

United States, Canada, Mexico, Brazil, United Kingdom, Ireland, Germany, 
Netherlands, Spain, France, Belgium, Norway, Finland, Sweden, Denmark, 
Luxembourg, Portugal, Italy, Austria, Switzerland, Saudi Arabia, Turkey, Tanzania, 
South Africa, Australia, New Zealand, Philippines, Japan, Taiwan, Hong Kong, 
Singapore, Thailand, and Malaysia.



Company Background

1Soft Corporation was founded in 1990 to bring Above & Beyond to all those who 
could benefit from using it. It is a company with a single product, a single focus: 
helping you make the most of your time.

1Soft headquarters is located near Eugene, Oregon.



Time Management

Conventional Methods
Dynamic Scheduling
Advantages of Schedules over To-do Lists



Conventional Methods

People have traditionally used four common reminder systems. There are some 
drawbacks to each of these methods, but fortunately today we have a solution that 
improves on all of them.

1. Physical view. Leaving items to work on in physical view is the simplest system, 
but has limited effectiveness. Offices and desks soon become cluttered and stacked 
so high with objects, that some become hidden, and easily missed. Further, focusing
on the current task is impaired because of the surrounding distractions. Also, there 
is no record of when tasks were completed.

2. In-baskets and action folders. These work well for certain types of tasks, but only 
as far as they are uniform in priority, duration, and deadline. You have to physically 
view each document individually. There is no summary list of items which you could 
prioritize. There's a danger that time-critical items may not be dealt with at the right
time. Review is a problem. There is no record of when things were completed.

3. Appointment calendars. These work fine for appointments, but not general work 
load. They are ineffective for the hundreds of tasks you want to accomplish each 
week, because tasks frequently need to be juggled from day to day and hour to 
hour. Appointment calendars with their fixed-length slots do not accomodate tasks 
well, nor make it easy to shift them. 

4. To-do lists. Listing tasks is a good way to remember them, but doesn't create a 
clear plan for effectively doing them. Unstructured to-do lists can quickly become 
lengthy, making copying tasks, and scanning items take considerable time.

The next section explains the long awaited time management breakthrough: 
Dynamic Scheduling.



Dynamic Scheduling

Above & Beyond harnesses the power of your PC to create a system that works for 
you.

There's an innovative technology in Above & Beyond called Dynamic Scheduling. 
You can quickly enter any tasks you want to do. Then, take your mouse and move 
items around on-screen for instant planning. As you juggle items, each day's plan 
updates automatically. 

Choose explicit times and dates only for appointments and events. For tasks, Above 
& Beyond will calculate a planned begin time automatically, based on everything 
you have to do. For the bigger picture, you'll see the workload level of upcoming 
days or weeks in a pop-up month calendar. You can prioritize the items and even 
use workload balancing to have everything refitted automatically. This keeps your 
schedules from being too heavy or too light. Choose exactly the workload level you 
desire.

Above & Beyond frees you from the manual labor of conventional time management
methods. You can do what you do best: make decisions about what's important to 
you, and focus on doing what you want to do. It frees your mind from the clutter of 
remembering everything, and the stress of constantly figuring and refiguring 
whether everything is going to be done by deadline. With Above & Beyond    you 
have a clear sight on exactly where you're going, and when you're going to get 
there. 

Above & Beyond is today's most effective planning system for day-to-day 
management. With your workload prioritized and effectively streamlined, your 
productivity can soar.

Above & Beyond serves you in all three perspectives:    Planning, Prompting and 
Reviewing. You plan on-screen -- easily juggling items as schedules recalculate 
instantly. Use the generated schedules as a guide for prompting throughout the day.
And everything completed is available for review.



Advantages of Schedules over To-do Lists

A to-do list is a prioritized list of items. A schedule is a chronologically ordered, 
prioritized list of items in the structure of a time-based plan. With Above & Beyond 
you can prioritize your to-do list on-screen and then have your workload 
automatically flow into schedules. There are several advantages in schedules:

1. Because time is allocated for each task, a schedule clearly shows what can be 
accomplished on a given day. This helps you budget your time. Basic to-do lists give
you no indication of how much time they represent. A schedule gives you a plan for 
the day. You can start to visualize what you'll be doing, and be prepared when the 
time arrives.

2. Schedules serve as a guide. A well-planned schedule can be followed smoothly. 
To-do lists require frequent stops to read the list and decide what to do next. With a 
lengthy to-do list and no schedule, each stop can take from 2-5 minutes. Over the 
course of a day with 30 items or 30 stops, using a schedule instead of a to-do list 
can save you between 60 minutes and 2 and 1/2 hours.

You may be wondering, "but don't schedules take a long time to compose?" Not 
anymore. Above & Beyond does the work of creating each day's schedule for you 
instantly.
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Key Features of Above & Beyond

All the features you need for reaching your potential.

- Dynamic Scheduling with state-of-the-art interface for clear and easy on-screen 
planning
- A full-range of recurring item scheduling choices and carry-over options
- Exceptions to recurring Items; modify/cancel one or all occurrences
- Special item colors for 8 user defined item Statuses.
- Any number of color coded user defined Projects to which items can be assigned.
- Project reports showing total time spent on each project.
- Prioritization w/ deadlines and postponements
- Floating and Fluid tasks
- Workload Balancing
- LAN/Group scheduling, E-mail and Meeting Maker with RSVP.
- Password protection (3 levels), private items
- Mobile computing, supporting file exchange with portable PCs
- Phone/Address/Note books
- Auto-dialing
- Pop-up rate-based timer for phone call tracking or billing
- Item timers
- Agents (automated launching of applications and batch files at preset times)
- Choice of    all TrueType fonts on screen, and in reports
- Dozens of report options: Day, Week, Month, Range, Priority List, 
portrait/landscape, more
- Date and time entry short-cuts, eg. "today", "Sa", "10" days from now.
- Logging of all completed items for later recall.
- Automatic follow-ups.    
- Perpetual calendar through the year 2068
- Alarms with snooze option
- Plenty of room for item descriptions
- Notes attached to items, huge capacity, copy/paste to/from other applications
- Optional conflict checking
- Carry-over of undone items
- Automatic, background file-saving
- Week at a glance in variety of screen layouts
- Month at a glance with item descriptions
- Pop-up color utilization calendar, showing relative workload across entire month
- World time-zone clocks
- Import and export
- Choice of page sizes for printed schedules (DayTimer, Filofax, etc)
- Small datafile size (eg. a heavy workload of 300 items consumes less than 50K 
disk space)
- A clean interface, without screen clutter for clear, unconstrained views



Registration/Ordering a License

You can order an Above & Beyond license directly from 1Soft by mail, phone, or fax 
with a check or credit card (VISA/MC/Amex). The program will generate an order 
form for you. From the Options menu, select Order an Above & Beyond License. In 
return, we'll send you the complete package, including a printed user's guide, a disk
containing the latest version, and your personal user ID. 

If you're outside the U.S. you can order with a credit card, check, or International 
Money Order.    Checks and Money Orders must be in U.S. dollars.

This copy of Above & Beyond is the complete program; there is nothing held back. 
You can start using it immediately to plan your schedules: entering appointments, 
tasks to do, recurring items, etc.    When you register, you'll receive a user ID which 
enables you to continue to use the program, retaining all the data you've entered.

As a registered user you'll also be entitled to substantial discounts on future 
upgrades.



Send your Comments and Requests

Your questions, comments and requests for enhancements are welcome. Email to 
71240.1625@compuserve.com or fax to (541) 822-3300. By postal mail, please 
address your comments to:

1Soft Corporation
Product Comments
Post Office Box 401

Blue River, OR 97413



Share the Benefits

Many people you know could benefit from using Above & Beyond.    Fortunately, this 
program is authorized for shareware distribution.    Shareware means you can freely 
copy our software to evaluate it.    It's a try-before-you-buy method.    We encourage 
you to make copies of Above & Beyond, and give them to others to evaluate. 

Please feel free to upload Above & Beyond to any of your favorite BBS's, To make it 
simple we've included a DOS batch file, ZIP.BAT to create AB.ZIP with the right files.  
A program description is in the file FILE_ID.DIZ. 

Shareware

We provide Above & Beyond as shareware. As a user, you pay us only if you intend 
to use it beyond evaluation. The process of purchasing a license is also known as 
registering. 

1Soft Corp. is a member of the Association of Shareware Professionals (ASP). ASP 
wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help. The ASP Ombudsman can help you 
resolve a dispute or problem with an ASP member, but does not provide technical 
support for members' products. Please write to the ASP Ombudsman at 545 Grover 
Road, Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to
ASP Ombdusman 70007, 3536.



Legal Requirements

You are authorized to make only exact copies of Above & Beyond files to give to 
others for evaluation purposes. Modifying the program files in any way is strictly 
prohibited. 

Only individuals licensed by 1Soft Corporation are authorized to use Above & 
Beyond files on a continuing basis. Continued active use without registration is 
prohibited. Various shareware distributors have been authorized to sell disks 
containing Above & Beyond. They are selling disks and a distribution service only. 
They are not selling Above & Beyond licenses. 

Liability Disclaimer

1Soft Corporation specifically disclaims any warranty of merchantability or fitness 
for a particular purpose. With respect to defects in its programs and supporting 
materials and service, in no event shall 1Soft Corporation be liable for any loss of 
profit or any other commercial damage, including but not limited to special, 
incidental, consequential, or other damages. Use this program at your own risk.

Copyright/Trademark Information

The software files that comprise Above & Beyond are Copyright © 1996 by 1Soft 
Corporation.    All rights reserved.    Unauthorized use is a violation of U.S. and 
international copyright laws.    1Soft and Above & Beyond are trademarks of 1Soft 
Corporation.
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Single User Installation

The installation process allows you to select where you would like to put Above & 
Beyond files.    The directory you name will be created if it doesn't already exist; and
the files will be copied from the diskette to this target directory.    Some files are in 
compressed form on the diskette and will be automatically uncompressed as they 
are installed.

Step 1: Insert the Above & Beyond diskette into drive A.

Step 2: From the Windows Program Manager, select File: Run and type:

A:INSTALL

You will be prompted to specify the name of a directory in which to install the files.    
You may overtype or accept the default shown.    You will also be asked if you'd like 
an Above & Beyond icon created.    Answer "yes" if installing for the first time.

Note: If you have schedule data from a previous version of Above & Beyond, install 
the new version into the old directory and your data will be automatically loaded 
into the new version.    If you wish to save the old version of A&B.exe, copy that one 
file to another directory before installing the new verison.

Step 3:    Start Above & Beyond by double-clicking on the icon.



Installing Above & Beyond for a LAN Workgroup

1. Install Above & Beyond on each PC as described in the section on single user 
installation.

Note: Although you can install the program file AB.exe in a shareable directory on 
the server, and have your workstations access it there, it will run faster if installed 
locally. This is because Windows will not have to repeatedly access the server hard 
drive to read parts of the program code into memory. If installed on the local 
workstation, Above & Beyond will not only load quicker, but it will also operate at a 
faster, more responsive pace. This is true for all Windows applications. 

2. Designate a sub-directory on the server's hard drive specifically for each user. 
Their datafiles, notes, and email will be stored here.

3. If J: is the name of your server drive, then the Above & Beyond icon command 
line on a typical workstation could be as follows:

C:\AB\A&B.exe    J:\Bill

Note: This will create a Timedata.pak file in J:\Bill. If the directory does not yet exist 
it will automatically be created when Above & Beyond is run.

See the Schedules Menu section for information on setting up access to the 
schedules of other workgroup members.
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Schedule Notation

At the top of each schedule is the following information: the day and date of the 
schedule, the number of items in that day's schedule, the amount of time taken up 
by the items in the schedule, and the amount of time left unscheduled in that day 
(open or free time).    If there are "conflicting" items -- items that are scheduled for 
the same time period -- the total overlap time is displayed.    On past schedules, the 
number of undone items will also be reported in the banner line.
 
If the schedule being viewed is the one for the current day, an asterisk (*) will 
appear after the date in the banner line.    If there are undone items on a previous 
day(s), a <- symbol will appear to the left of the first seven items to remind you of 
the undone items.    Otherwise, the first seven undone items will be preceded by the
numbers 1-7.    This is called the Batting Order feature, and is designed to quickly 
alert you to whats next to do.

A slash (/) appearing before an item's text on today's schedule indicates the item 
cannot be done right now, because its earliest begin time has not yet arrived. This 
way you can scan today's schedule and know that you can begin now any item that 
doesn't have a slash before it.

If the schedule being viewed is not the schedule for the present date, a number will 
appear after the date in the banner line preceded by a plus (+) or a minus (-).    A 
number preceded with a plus indicates that the schedule being displayed is that 
number of days in advance, or in the future, of the present date.    A number 
preceded by a minus indicates that the schedule shown is that number of days 
behind, or in the past from, the present date.

An arrow (>) will appear before the title of the item that is scheduled for the current
time. Black dots before (or between) items indicate the relative duration of the item 
(or time between items.)    Larger dots indicate a longer duration.    Schedule 
statistics will change as items are added, deleted from or modified in a schedule or 
as schedules for different days are selected.    Related topics: Red Begin Time and 
International Time & Date Formats 

There are some indicators that appear beside item descriptions in the schedules:

-r a standard instance of a recurring item.
-rx an exception to a recurring item
-a alarm set
-ax alarm has already gone off today
-ar alarm already gone off today, but will repeat later ("snooze").

A small digital clock will appear on screen whenever Above & Beyond is running 
(unless you have selected Options:Clock Off).    When it is on, you can switch back to
Above & Beyond from any other application simply by clicking once on the clock.    
You can drag the clock to any screen position you desire.



Red Begin Time

On today's schedule, item start times will appear red if the begin (or latest begin) 
time has already past.    Also, if you move an item to a place where it conflicts with 
another item or goes outside of the time bounds you designated, the time will 
appear red; warning you of the conflict.    Keep this in mind when juggling items.



International Time & Date Formats

Above & Beyond supports world-wide date and time formats.    Use the Windows 
Control Panel to select your choice of time and date format.    For example: 

    3:00mm/dd/yy United States, Taiwan
15:00 dd/mm/yy Australia, United Kingdom, Belgium, Brazil 
15:00 dd/mm/yy Italy, Netherlands, Iceland, Spain, New Zealand 
15:00 dd.mm.yy France, Germany, Norway 
15.00 dd-mm-yy Denmark 
15.00 dd.mm.yy Finland 
15,00 dd.mm.yy Switzerland 
    3:00dd/mm/yy Mexico, Canada (English) 
    3:00yy.mm.dd South Korea 
15.00 yy-mm-dd Sweden 
15:00 yy-mm-dd Austria, Portugal, Canada (French) 



Selecting Schedules

To display the schedule for a desired day, click on the date on the pop-up calendar.   
If using only a keyboard, see The Select Menu.

There are several methods for moving between schedule days.    You may move 
ahead or back by days, weeks, months, or years.    These methods are explained in 
the sections that follow.    Remember that no matter how far you go ahead or back in
time, you can always return to today's schedule by simply pressing the HOME key.    

Selecting a Specific Date
Selecting a Day at a Time
Selecting a Week at a Time
Selecting a Month at a Time
Selecting a Year at a Time



Selecting a Specific Date

To select a schedule for a specific date, simply click on the desired date on the pop-
up calendar. Or press F9 and type in the date.

Dates may be entered as "mm/dd/yy" using slashes, hyphens, spaces or periods.    
Often the year may be omitted.    See Entering Item Date for information on when 
the year may be omitted and for many other shortcuts for entering dates in Above 
& Beyond.



Selecting a Day at a Time

There are shortcuts to selecting the schedule for date one day earlier or later than 
the one being displayed: 
 
To advance the viewed schedule one day, press the gray PLUS (+) key on the 
numeric key pad, or click the right arrow toolbar icon. 
 
To go back one day, press the MINUS (-) key on the numeric key pad, or click the left
arrow toolbar icon.



Selecting a Week at a Time

There are shortcuts to selecting schedules weeks apart:

To view the day one week earlier, press F7, or click the double left arrow toolbar
icon.

To view the day one week later, press F8, or click the double right arrow toolbar 
icon.



Selecting a Month at a Time

The pop-up calendar can be used to quickly move the display ahead or back a 
month at a time.

To advance the calendar one month, click on the scroll-bar up-arrow to the right of 
the pop-up calendar.    Then, click on the desired date in the calendar and that 
schedule will be displayed.    To go back one month, click on the scroll-bar down-
arrow.    When the calendar has the focus, you may also use the up and down arrow 
keys to move a month at a time.



Selecting a Year at a Time

When the pop-up calendar has the focus, you may move ahead or back one year at 
a time with the PageUp and PageDown keys .

Alternatively, you may use the vertical scroll-bar to the right of the pop-up calendar 
as follows: To advance one year, click in the gray area in the top half of the scroll-
bar. Then, click on the desired date in the calendar and that schedule will be 
displayed. To go back one year, click in the gray area in the bottom half of the scroll 
bar.
 



Schedule Items

Inserting
Recurring
Editing
Deleting
Marking Done
Carrying Over
Juggling
Highlighting



Inserting Items

Press INSERT,    or double-click on any open space on the schedule screen (not on a 
existing item).    A dialog box will appear for entering the item's definition.

Entering Title
Entering Duration
Entering Memos
Entering Date
Scheduled / Unscheduled
Begin Time and Floating / Fixed
Firm / Fluid
Time Bounds
Setting Alarms
Projects
Automatic Follow-ups



Entering Title

The title (description) of your item can be up to 365 characters.    Ctrl+Enter can be 
used to limit the amount of description text that appears on the schedule.    Text 
following the Ctrl+Enter will be denoted by an ellipsis, and can be viewed by 
pressing Shift+V.



Entering Duration

The duration is the amount of time you plan to spend on the item. If you are 
uncertain of the duration, your best estimate will still be helpful for planning.
 
You may enter complete times like "2:00" for two hours or "1:45" for 1 hour and 45 
minutes, or you may use the following shortcuts:    The numbers 1 through 99 are 
interpreted as minutes, while 100 through 2359 will be assumed to be hours and 
minutes.    For example, "145" is assumed to be 1:45.    You may enter durations of 
up to 24 hours.

Note that a period can be used in place of the colon.    This European format is 
easier to type because the shift key is not required.    The quickest way to enter two 
hours is 2.



Entering Memos

A "memo" is an unscheduled item with duration zero.    Memo items appear at the 
top of your schedule with the word "memo" in place of the begin time.

To enter a memo into your schedule, press Alt+Insert or select "Edit: Insert Memo 
Item".



Entering Date

This is the date on which your item is to appear.    The default is the date of the 
viewed schedule.

Dates may be entered as "month/day/year" using slashes, hyphens, spaces, or 
periods as separators.    

Examples: 9/23/92            9-23-92            9 23 92              9.23.92

You need use only two digits to specify the year.    Specifying values between "90" 
and the "99" are assumed to be years between 1990    and 1999.    Specifying values
from "00" to "68" are assumed to be years between 2000 and 2068.    If you omit 
the year, (e.g. 9/23) the year will be assumed to be the next occurrence of the date. 
The exception to this is if the date is within six months in the past.    In this case the 
date is assumed to be the past date rather than the next (future) occurrence of the 
date.

To specify "n days from now" type a number "n".    To specify "n days ago" type "-n".

To specify one week from now, type "1w".    For two weeks ago, type "-2w".    For two 
months ago, type "-2m".    For two years from now, type "2y".

For weekdays, you may use abbreviations such as "M", "Tu", "W", "Th", "F", "Sa", or 
"Su".    To select next Monday, type in "M".    For one week from next Monday type 
"M1".    For two weeks from next Tuesday, type "Tu2".    Upper or lowercase are 
accepted.

See also International Date and Time Formats. 
 



Scheduled / Unscheduled

When an item is inserted into a schedule, the default setting is "Scheduled" which 
means it will be considered in time management operations such as Workload 
Balancing and calculating daily totals.

You can toggle an item between scheduled and unscheduled with F4.    Generally, 
the only unscheduled items you will have will be memos.



Begin Time and Floating / Fixed 

When you leave the "Begin time" field empty, an item is considered to be "Floating".
This means your item can take place over the range of time specified in 
Options:Settings:New Item Defaults.    The item will be inserted into the schedule at 
the earliest open time, taking into account the duration, other items already 
scheduled, and the bounds you specified in New Item Defaults.

You can change the sequence of items by dragging them up or down (or using the 
commands in the Juggle menu).
 
The dynamic scheduler    will do much of the scheduling work for you. To maximize 
the power of dynamic scheduling, omit the begin time for all those items which 
have a flexible start time.    Enter a time in the "Begin Time" box only if an item 
must begin at a specific time, such as a lunch date or meeting.    To convert a 
"Fixed" item to Floating, press Alt+F2.
 
In 12-hour format, times may be entered as "945a" for 9:45 am or "330p" for 3:30 
pm.    If the "a" (am) or "p" (pm) is omitted, it will automatically appear between 
8:00am and 7:59pm.

In 24-hour format enter "500" (or "0500") for 5:00 am and "1708" for 5:08 pm.    Use
the Windows Control Panel to select 12/24-hour and international time and date 
formats. 



Firm / Fluid

If an item is not required to be done on a particular day, make it "Fluid" by pressing 
F2 or removing the "x" from the "Firm" check box.    "Fluid" items can be prioritized, 
and can flow (forward or backward) between days when the Balance Workload 
command is selected. Balance Workload will reschedule Fluid items based on their 
priority and the best fit into the available free time.

You may specify weekdays and/or a date range within which a Fluid item may flow.   
This is done in the "Flow" area of the Insert/Change item dialog.    The item will be 
scheduled after the "Postpone" date and before the "Deadline".

For an in-depth discussion of Fluid items, see the section titled Workload Balancing.



Time Bounds

For Floating items, you may select a time range in which you would like to have the 
item scheduled.    For example, if you need to make a phone call to a colleague who 
will only be in his office between 9:00 and 11:30am tomorrow, enter these times in 
the boxes labeled "Earliest" and "Latest".    The dynamic scheduler will do the rest.

If the bounds boxes are left empty,    the bounds used will be those you have 
specified in Options:Settings:New Item Defaults.    In addition to saving keystrokes, 
this method has the additional benefit that you may later "globally" adjust the 
bounds of all floating items by simply changing the bounds in Options:Settings:New 
Item Defaults.

For "fixed" items (items with a fixed begin time) the "Bounds" boxes will be seen in 
gray and will be inactive. 



Setting Alarms

Alarms may be set on any scheduled item.    When the alarm sounds, a message will
pop up alerting you to the start or end time of the item.    You may choose to have 
the alarm remind you again in a specified number of minutes.

To set an alarm, click on the "Alarm" button in the Insert/Change item dialog. To 
disable the alarm, remove the "x" from the Alarm button check box.

When an alarm is set, the item will appear on your schedule with "-a" after it.    An 
item followed by "-ar" indicates that the alarm has gone off and has been set to 
repeat again later today.    An "-ax" indicates that the alarm has gone off and will not
be repeated today.

If you prefer that alarms appear on screen but with no sound, click on "Set Sound" 
and select "None".    The alarm sound may also be set in Options:Settings:Alarm 
Sound.    If you have a Windows sound driver installed, you may specify a wave 
(.wav) file to replace the default alarm sound.



Projects

If you have set up Projects, you may categorize the current item by selecting one of 
the projects in the drop-down list-box. For for more on Projects see View: Projects in 
the Menu Reference section.



Automatic Follow-Up

When you wish to follow-up on an item some time after it has been done, check the 
Follow-Up box in the Insert/Change Item dialog. When the item is marked done, a 
duplicate of the item is automatically created. Choose a date for the duplicate item 
(or make other refinements) then click "OK".



Recurring Items

To make an item recurring, click "Recurring" in the Insert/Change Item dialog.

Choose from the many options: daily, every so many days, weekly, every so many 
weeks, monthly, every so many months, annually, or every so many years.    A 
starting date is required, and is initially set to the currently viewed date.    An ending
date is optional.    If the ending date is left blank, the item will be scheduled 
indefinitely.    For weekly and monthly, if all boxes are left unchecked, occurrences 
are based on the starting date.
 
You can later choose to delete one or all occurrences. See Edit: Delete Item or Edit: 
Delete All Occurrences.

Cardinal Month Days
Ordinal Weekdays
4-4-5 Quarterly Calendar
Entering Birthdays
Entering Multiday Activities
Recurring to Non-recurring
Delete All Occurrences
Exceptions to Recurring Items
Carry Over Options



Cardinal Month Days

A recurring item can be scheduled to appear on particular days of the month. To 
schedule an item for the last day of every month (even those with fewer than 31 
days), choose 31.

Suppose you want an item to appear on the Friday nearest the 15th of the month.    
Select 15 and Nearest and select Friday on the weekdays list above.    Select 
On/Before to have the item appear on the selected weekday (eg. Friday) on or 
before the 15th.    Select On/After to have the item appear on the selected weekday 
on or after the 15th.



Ordinal Weekdays

Use this option to schedule your item on a certain day each month; for example, the
first Friday and the second Wednesday of every month.    



4-4-5 Quarterly Calendar

While the traditional quarter begins on the first day of the first month of the quarter,
in the 4-4-5 system, the quarter begins on the first day of the first week of the 
quarter. The first month of the quarter always has 4 weeks, the second month 4 
weeks, and the third 5 weeks. 4-4-5 quarterly calendars are popular because of 
their uniformity. 

Many companies make frequent use of the 4-4-5 system to schedule recurring 
meetings. Here are a few examples:

1)    Meeting on the 4th Wednesday of each month
2)    Meeting on the 2nd Tuesday of each quarter
3)    Meeting on the 7th Friday of each quarter.

1)    Use as a starting date the first day of the first quarter you want to schedule it. 
Then choose every month, 4th Wednesday.

2)    Use as a starting date the first day of the first quarter you want to schedule it. 
Then choose every 3 months, 2nd Tuesday.

3)    Use as a starting date the first day of the second month of the first quarter you 
want to schedule it. Then choose every 3 months, 3rd Friday.

If you don't know the first day of a particular 4-4-5 month or quarter , you can 
simply enter the first day of the corresponding traditional month and it will be 
converted.

To have Month at a Glance, the pop-up Calendar, and the Extended Outlook (13 
week printout) appear in 4-4-5 format, select Options: Calendar: 4-4-5.    To toggle 
this option off, simply select it again.

In addition, with the 4-4-5 calendar option selected, the following information is 
displayed on each Sunday in Month-at-a-Glance:    The number of the week (1-52) is 
shown in parenthesis.    Then the month and number of the week within that 4-4-5 
month is shown.    For example:    "(50) Dec:3" indicates that    the week is the 50th 
week of the year; and the third week of the 4-4-5 month of December.



Entering Birthdays

From the Recurring dialog box, choose "Annually".    Specify "Starting Date" as the 
next occurrence of the birthday; not the actual date the person was born.    The 
reason for this is that    the actual day they were born may be outside of the range 
of Above & Beyond dates.

Alternatively, you may want to enter birthdays two weeks prior to the next 
occurrence of the birthday and have it read e.g. "Mary's birthday: mm/dd/yy."    This 
will allow you time to send a card, plan a surprise party, etc.



Entering Multiday Events

If you wish to block off several days for a special event, set up a daily recurring item
using the date range of the event.    To block off the entire day, set a begin time and 
use a duration that spans the whole day.    You may also want to highlight the item 
so it will appear on the month view.



Recurring to Non-recurring

To change a recurring item to non-recurring, remove the "x" from the "Recurring" 
check box in the Insert/Change Item dialog.    All occurrences of the item will be 
deleted with the exception of the one instance that is selected.



Delete All Occurrences

To remove all occurrences of a recurring item, select any occurrence of the item on 
any schedule, then select "Delete All Occurrences" from the Edit menu.
 
Alternatively, choose View:Alphabetical List, select the recurring item, and press the
DELETE key.



Exceptions to Recurring Items

Perhaps a meeting which is normally scheduled to take place on the first Monday of 
every month will be moved to the following Tuesday because of a holiday that 
Monday.    Or perhaps on Friday, your daily lunch, normally from 12:00 to 1:00 needs
to be moved to 12:30 and extended to 90 minutes.    These exceptions are easily 
handled    in Above & Beyond.

When you bring up the Insert/Change Item dialog to edit a recurring item, the 
"Exception" button is automatically selected.    This indicates that this is an 
exception to the normal recurring definition for this item.    If you want this definition
to become the new standard, click on "Standard"    To simply cancel one occurrence 
of the item click on "Cancel". 

You can also create an exception simply by dragging or moving a standard instance 
to another day.



Carry Over Options

You may flag specific recurring items so that they will not be carried forward in the 
normal fashion but instead be deleted or shifted.    These options are selected in the 
Carry Over Options section of the recurring item dialog box.

Carry Over Options: Delete

When you select Carry Over Undone Items, any undone items with the delete option
will be deleted rather than carried forward. Use the delete option if you have a 
recurring item that you dont want carried forward if undone.    An example of this 
might be a daily item such as lunch.    Because lunch is a daily item, there will 
already be a new occurrence of lunch each day. Without the delete option, it would 
be carried over and thus appear twice.    

Carry Over Options: Shift

Suppose you have a recurring item called "Mow the lawn" set for every 7 days.    If 
not done on a particular day, you want all occurrences of the item to be shifted 
ahead so that there is still a 7 day span before the next occurrence.    In Carry Over 
Options, select "Shift".    Now, whenever you issue the Carry Over Undone Items 
command, all future occurrences will be shifted ahead.

Note: The Shift feature simply updates the "start date" of the recurring item with the
date of the day you are carrying over to.    It is designed for items that occur every n
number of days, weeks, months or years. For this reason it will work only for 
recurring items where no specific weekday or month day is selected.    For example, 
select "Weekly" and type in the desired start date; but do not use the particular 
check boxes "M", "W", etc.    Similarly with Monthly items.



Editing Items

To change attributes of any item, double-click on the item (or select the item and 
press ENTER).

To change all instances of a selected recurring item, press Ctrl+Enter.    Changes will
affect all standard instances of the item.    Exceptions will not be affected.



Deleting Items

To delete a selected item, press the DELETE key.



Done Items

When a selected item is "done", press the SPACEBAR.    A line will appear through it 
indicating it is a "done" item.    See Edit: Item Done for more on done items.



Carry Over Undone Items

To move undone items ahead to present day or a selected future day, press F12, or 
click on the suitcase icon in the toolbar.    If the viewed schedule is today or a past 
day, all undone items will be moved to today. If the viewed schedule is a future day,
the items will be moved to that future day.

See also Carry Over Options in the Recurring Items section.



Highlighting an Item

For emphasis, you may wish to "highlight" certain items on your schedule. 
Highlighted items appear in the schedule as underlined.    F3 or Edit:Highlight Item 
will underline the currently selected item.    Press F3 again to remove the underline.

The Month-at-Glance view and certain reports include only highlighted items.    See 
Reports in the Menu Reference section.



Juggling Items

Once an item is inserted into your schedule, you may easily move it to a different 
position within that schedule or move it to the schedule of a different day.
 
Click to select the item you wish to move, then simply drag the item up or down 
within the schedule. When you move a "Floating" item up or down in the schedule, 
the begin time will adjust automatically. You may also drag "Fixed" items, however 
the begin time you specified remains the same.
 
If you move an item to a spot where it conflicts with another item or goes outside of
the time bounds you designated, the time will appear red warning you of the 
conflict.
 
To move a selected item to another date, click with the right mouse button on the 
desired target date in the pop-up calendar. This is the quickest and easiest way to 
re-schedule an undone item to another day.    While viewing multiple schedules, you 
may drag the selected the item from one schedule window to another.

See The Juggle Menu for a list of keyboard shortcuts for moving items.



Views

One to seven schedules can be viewed on screen simultaneously.    The schedules 
may be tiled vertically or horizontally.    You may also view a list of all items ordered 
by priority, or alphabetized on item title.    These view options and others such as 
Month-at-a-Glance are selected in the View menu.    Month-at-a-Glance shows all 
highlighted items for the month. For more information on views, see The View Menu 
in the Menu Reference Section.



Printed Schedules

You may print a variety of reports from Above & Beyond.    For details, see Reports in
the Menu Reference section.

Printed schedules have vertical spacing proportional to time span.    This makes it 
easier to see the relative durations of each item.    Items of longer duration will have
more blank space below the row they appear on, than those of shorter duration.



Notes

Notes of varying lengths can be attached to items. They may also be printed.    For 
more information on notes, see Edit:Notes in the Menu Reference Section.



Data Saving and Backups

To minimize data loss from unexpected natural disasters such as power 
interruptions, schedule changes are automatically saved every 60 seconds in your 
data file which has the .PAK extension.    As an added precaution,    a backup file 
(with the extension .BAK) is maintained which contains your previously saved 
scheduling data.

Your data is vital, especially the scheduling data you rely on to plan your future and 
to track your accomplishments.    ON A DAILY BASIS, MAKE BACKUPS of all the data 
files in your Above & Beyond directory and subdirectories. These backups should be 
made on reliable media and stored in a safe place.

You may have an Agent do these backups automatically.    For details, see Agents.



Schedule Archiving

A schedule will be "archived" when all items on that day have been either marked 
done, rescheduled, carried forward, or deleted, and the day is past.    In other words,
when all items remaining on the past day are done. Archived schedules are stored 
in "x-files" that have an extension determined by their year. For example, 1996 
archived schedules are stored in Timedata.x96. These files are encrypted and are 
written and read by the program itself when displaying and updating past days' 
schedules.

In addition to x-files, there are "log" files which contain a month of done items, and 
are named for the month, eg. Jan97.log. They are text files that can be read into a 
spreadsheet program for analysis, or simply viewed or printed. A log file is 
appended when a schedule within that month is archived; and rewritten if a 
previously archived schedule within that month is updated. Therefore if you want to 
annotate a log file, you'll probably want to first make a copy of it, as the original will
be overwritten if you make a change to any past schedule in that month in Above & 
Beyond.

To view the log file for a particular month from within Above & Beyond, select any 
schedule in the month; then choose View: History for Month.    The log file will be 
displayed in Windows notepad. Log files are formatted with tab-separated values so 
they can also be read as text files by spreadsheets such as Microsoft Excel and 
Lotus 1-2-3.    To make it simpler for your calculation formulas, durations are in 
minutes.

Log files also contain a four or five digit number indicating the project to which an 
item is assigned.    For a list of project names and numbers, use File: Reports: List: 
Report.



The Toolbar

Just below the Above & Beyond menus is a toolbar which contains icons for quickly 
accessing a variety of commonly used commands. To remove the toolbar from view,
click on the small icon just above the vertical scroll bar.    To restore the toolbar, click
again.    You may also toggle Toolbar Off in the Options menu.

Select: Prior Week

Select: Prior Day

Select: Today's Schedule

Select: Next Day

Select: Next Week

View: Single Schedule Window

View: Week at a Glance

View: Month at a Glance

View: Alphabetical List

View: Priority List

Select: Find

Options: Calendar: Open

Worktools: Timer

Worktools: Autodial

View: Browse Notes



Edit: Notes

Edit: Start Item

Edit: Item Done

Edit: Delete Item

Juggle: Carry Over Undone Items

Juggle: Balance Workload

File: Print: Standard Report

Zoom In

Zoom Out

Zoom In and Zoom Out

The last two toolbar icons allow you to quickly increase or decrease the size of 
normal text or headings on your screen. To increase the text size, click the large 
magnifying glass icon. To reduce, click the small magnifying glass icon.    To adjust 
schedule headings, hold the Control key while clicking on the Zoom In or Zoom Out 
icon.

You have the added flexibility of different text sizes for different views.    For 
example, you can increase the size of the text in Month-at-a-Glance without 
affecting the text size in Single Schedule view.



Advanced Use

Projects
Item Status/Color
Accounting for Time
Workload Balancing
Night Owl Support
Agents
Macros



Projects

For information on Projects see View: Projects in the Menu Reference section.



Item Status/Color

Schedule items may be one of eight user definable statuses.    Items with a 
particular status can appear in any color you choose.    The "status" of an item may 
be easily set by clicking on the item with the RIGHT mouse button (or by pressing 
Ctrl+F3).    For more information on setting item status/color, see 
Options:Settings:Statuses.

Regardless of status, you may choose special colors for Fluid items and/or 
Unscheduled items.    These colors are choosen in Options:Settings:Colors.



Accounting for Time

Above & Beyond includes several commands for time tracking.    You can indicate 
that you've started working on a task by issuing the Start Item command.    This 
starts a task-timer running and shows on-screen how long you've been working on 
it.    When you complete the task, marking it done, the actual time in the timer will 
be recorded as the duration of that item. 

If you decide later you want to resume working on that task, select it and issue the 
Start Item command again.    A second instance of the item will be created and a 
task-timer will be started.

To start the timer if you've already started working on the item, use Alt+F5.    This 
starts the timer and sets the begin time to the end time of the item last completed.

Even if you don't Start an item you can have the actual duration logged when you 
mark it done.    Instead of pressing Spacebar, press Shift+Spacebar (shortcut for 
Edit: Item Done, Fit to Gap).    The task will be given a duration that fills the 
intervening span of time.

Insert Done Item is a useful command when you're tracking your time.    This is for 
recording any unplanned items that you accomplished.    It's a handy command 
because the begin time is automatically initialized to the end time of the previous 
task.



Workload Balancing

Workload Balancing is an advanced feature that enables you to automate the 
scheduling of your undone tasks based on their priority and other requirements.    
Any tasks that don't have to be tied to a particular date can be designated as 
"Fluid" items and carry a priority and, optionally, a deadline. When you issue the 
Balance Workload command, Above & Beyond will reschedule all of your fluid tasks 
in a few seconds. This enables you to have priority-ordered schedules that smooth 
out lulls or crunches to produce optimized plans on demand.

How Workload Balancing Saves You Time

Workload Balancing relieves you of the work of manually rescheduling/postponing 
tasks when the schedules for the near term are overloaded with items. For most 
people the near term being overloaded is an everyday occurrence. But you can 
change that with Workload Balancing. Automated balancing of the workload is fast, 
and takes into account all priorities and deadlines. 

Priorities

Fluid items each have a relative priority based on their position in the Priority List. 
When you issue the Balance Workload command, all Fluid items are rescheduled 
dynamically. Precedence is given to the items in their order of priority. This means 
that all things being equal, higher priority items will be scheduled earlier than lower 
priority items. The priority 1 item may be scheduled today, for example, and the 
priority 145 item may not come up until next month.    See also, the section below 
titled Changing Priorities.

Earliest / Latest Dates And Weekdays

There are additional properties that fluid items have. The earliest date is known as 
the Postpone date. It is the earliest possible date you would want the item 
scheduled. The Deadline date serves as a latest date. It's the latest possible date for
it to be scheduled. For tasks that you would only want scheduled on particular days 
of the week, you can indicate with the weekday check boxes. For example, you 
might designate just Saturday, or maybe only Monday through Friday. These 
properties can be set on the Edit item dialog box. The Postpone date, Deadline date,
and Weekdays are all optional.

How To Create A Fluid Item

In the "Insert/Change Item" dialog, click on (to remove the x from) the Firm 
checkbox. This will switch off the Firm setting, making the item Fluid. If you are 



inserting an item from the Priority Ordered List view, the box will automatically be 
switched off to give you a Fluid item initially.

To toggle an item between Fluid and Firm press F2, or choose "Fluid Item" in the Edit
menu.    Recurring items are normally not Fluid, but you can make an exception. If 
you press F2 on one instance of a recurring item, it will change it to an Exception 
and make it Fluid.

Changing Priorities

The top priority item has a priority value of 1, the next 2, etc.    You can view all the 
Fluid items by selecting View: Priority List. The priority of an item can easily be 
changed in several ways. You can slide the item up or down in the Priority List to 
raise or lower its priority. Or you can edit the item and change the priority value by 
typing in a new value; or using the scroll bar to quickly move it up or down. 

The Balance Workload Command

Simply press Alt+F8 (or select Juggle: Balance Workload) and Above & Beyond will 
adjust item scheduling on all future days.    The priority, duration, and begin time (if 
any) is taken into consideration.    Higher priority items are given precedence, but 
there are exceptions. Items of shorter duration, for example, are easier to find time 
for, and may be scheduled before a long duration item of higher priority. 

If time cannot be found for the item before its deadline, a warning message will 
appear, and you'll have an opportunity to make changes, such as increasing its 
priority or extending its deadline.    When no messages appear you will know that all
tasks have been scheduled before their deadlines.

Using The Pop-up Calendar With Fluid Items

The pop-up calendar, so useful in quickly rescheduling Firm items, also has benefits 
in juggling Fluid items.    If you want to postpone a Fluid item to next week, click the 
right mouse button on the date to which you'd like to postpone it.    Don't worry 
about postponing past the deadline, because Above & Beyond will check deadlines 
and warn you before you exceed one.    You can then chose to not postpone the 
item, or have the deadline extended.    When you postpone an item it will not be 
scheduled prior to that date.    If you later decide you want to move it up, you can do
so by clicking on an earlier date on the calendar.    The Postpone and Deadline dates 
can also be changed in the Insert/Change Item dialog box.

Make Whatever You Can Fluid

To get the greatest gain out of Workload Balancing, designate as many items as you



can as Fluid. Ask yourself, "Can this be done on other than one particular date?"    
Events and appointments are normally Firm (not Fluid) items. But many things, 
perhaps 30-60% of your items could be Fluid. The more fluidity you have in your 
schedules, the easier it is to balance your workload.

How To Handle The Unexpected

If your work and lifestyle often has unexpected items that need to be handled that 
same day, set workload balancing to allow a certain amount of free time in the day.  
Otherwise, it will completely fill each day's schedule with planned items.    To specify
the amount of free time to reserve, select Options: Settings: Workload Balancing.



Night-Owl Support

For users who work past midnight, midnight can be "postponed" until you are 
finished working. In other words, items scheduled or completed after 12:00am are 
considered to be part of the previous days schedule.

To activate Night Owl Support, select Options:Settings:New Item Defaults and enter 
the latest time after 12:00am that you would work.



Agents

You can schedule an Agent to launch a batch file or application at a precise time.    
You can have the agent prompt you before it launches the program; or you can have
it launch automatically without asking permission.

Agents are activated by either of the two keywords, "Exec" or "Autoexec" appearing 
in the item title.    You may also specify parameters which will be passed to the 
program.    Windows and DOS programs, batch and command files can be run using 
Exec or Autoexec.

When the keyword "Exec" is used, and the scheduled begin time for that item is 
reached, an agent will display the current time and the message, "Ready to Exec 
<program name>?"    At that time, choose "yes" to run the program, or choose "no" 
to cancel the process.

When the keyword "Autoexec" is used, and the scheduled begin time for that item is
reached, the program will automatically be run without waiting for you to reply to a 
prompt.
 
At launch time, the agent can either mark the item done, or "start" (timing) the 
item; depending on your preference.    Use "Exec" or "Autoexec" (in mixed case) and
the agent will mark the item done.    Use all lower case ("exec" or "autoexec") and 
the item will be "started".    For details on "starting" items see Edit: Started in the 
Menu Reference Section.

You can manually launch an Exec or Autoexec item prior to its designated begin 
time.    Simply select the item, then press F5 (or use Edit: Start Item).    If the item is 
Floating, you will have to launch it manually, since a begin time is required for 
automatic launch.

Note: Unless you specify the path explicitly (e.g.    Exec    c:\mydir\backup.bat),    the 
PATH statement in your Autoexec.Bat file must include the directory in which the 
program or file is to be found.
    
The format for an Exec or Autoexec item title is: 
 
<Description>    <Keyword>    <Program name>    <Parameters> 
 
<Description> is any text.    <Keyword> is either    Exec, exec, Autoexec, or 
autoexec.
<Program name> is the    name of the program or executable file you want Above &
Beyond to load and run.    Programs or executable files must end 
in .EXE, .BAT, .COM, or .PIF.
<Parameters> are any information that the program needs to perform.

All of the four parts above are optional.    For example, you may want to use the 
keyword "Autoexec" with no program name to simply have an item automatically 
marked done.



The description, keyword, program name and parameters are all typed into the Title
line in the Insert/Change item dialog box, and they will be displayed on the schedule
in the normal fashion.    The keyword, program name and all parameters must be 
separated from each other by (only) one space.    

Exec Sample Item:

Backup notebook files    Exec C:\ab\backup.bat 
 
In this example, the description of the function you want to accomplish is "Backup 
notebook files".    The keyword Exec instructs Above & Beyond to prompt you before 
it loads and runs the batch file backup.bat.    This will give you time to put a blank 
diskette into drive A if, for example, Backup.bat contained the command "Copy    C:\
ab\*.nbk    A:".

Autoexec Example:

Meet with Bob Autoexec
 
In this example, the descriptive text is "Meet with Bob".    You chose the keyword    
Autoexe because you want this item to be marked done automatically without 
prompting you first.



Macros

There are two macros available for use: Rotate and Last Done.

Use the Last Done macro to have Above & Beyond automatically show the date the 
item was last done. To activate this macro, add "{last done}" to the item 
description. For clarity you may want to add: "(Last done: {last done})". The result 
of this would be, for example, "(Last done: 7/15/96)"

Use the Rotate macro anywhere in the description of a recurring item to alternate 
between a set of text strings for each instance of the item. For example, let's say 
you have four recurring items as follows: "Run backup: tape A", "Run backup: tape 
B", "Run backup: tape C", and "Run backup: tape D". You could instead have one 
item with description as follows: "Run backup: tape {A|B|C|D}". The text for each 
instance of the recurring item will rotate through the choices of substrings "A", "B", 
"C", "D" in order, and then repeat from "A". In this example, instead of having 4 
separate items defined to recur every 4 weeks, you need just one weekly item using
the Rotate macro syntax.



Workgroup Use

Above & Beyond is a big boost for workgroups.    Where workstations are connected 
via a LAN (local area network), managers can send balance the work-load of staff 
members, send E-mail, assign new items, prioritize work, and check task completion
status without interrupting on-going work. Above & Beyond automates the process 
of arranging meetings for group members, posting meeting notices to all attendee's
schedules. Secretaries can post phone messages for calls to be returned, and 
monitor multiple schedules to know who is where when. 

"Above & Beyond makes group scheduling easier than you ever thought possible... 
This is the way group scheduling should work."

- PC Magazine

Summary of Features
E-mail
Opening Schedules
Workload Management
Status Query
Passwords
Set LAN Directory
Meeting Maker
Alarms and Agents Off



Summary of Workgroup Features

1.    E-mail among Above & Beyond users. 

2.    View and update the schedules of other Above & Beyond users.    Password 
protection is also available as an option.

3.    Delegate items to co-workers.

4.    Check on the status of items being performed by others in the group.    If the 
item is completed you'll see it marked done; if it is coming up, youll when the 
person plans to get to it.

5.    Schedule meetings when everyone in a group is available.    

6.    Share a company phone book. If the company phone numbers are stored in a 
cardfile named "phone.crd" then simply add the following entry to each user's 
Worktools list:

Co. Phone Book nb.exe phone.crd

There must be exactly one tab (no spaces) before the nb and one space after exe.



E-mail

For details on this feature, see Edit: Send E-mail and View: E-mail in the Menu 
Reference Section.



Opening Schedules

In order to look at or update the schedules of others, you must first "open" the user;
which means that their schedules will appear on your screen.    A list of the "open" 
users is displayed in the Schedules menu.    For instructions on how to "open" users, 
see the section on The Schedules Menu .



Workload Management

Supervisors who assign work can monitor and adjust the workload and priorities of 
each worker in a precise way.    Above & Beyond schedules show clearly the 
workload on each day, in percentages, amounts, and even graphically with use of 
color on the pop-up calendar. 

Supervisors know ahead of time when a worker is running out of things to do, or on 
the other hand, if too much work is piling up.    Supervisors can see when workers 
will be getting to particular items, and shift the work sequence based on new 
priorities.



Status Query

Supervisors can check the completion status of any item at any time, without 
interrupting the worker. The worker doesn't even have to be available, which is 
important if they are working at another location, at lunch, on the phone, out sick, 
or on another shift. This is an enormous time saver. If the supervisor finds the item 
has not been completed, he can also see when the worker has planned to get to it.



Passwords

Users can be restricted for viewing and/or editing the schedules of other users.    
This is done by setting passwords for the various levels of access.    For more 
information See Options: Settings: Passwords in the Menu Reference section.



Set LAN Directory

The network administrator can now maintain a common user list (User.Lst) file that 
everyone's Above & Beyond will access. Specify the location of this file in 
Schedules:Set LAN Directory.

The More.. entry in the Schedules menu will bring up a list box with users who are 
listed in the User.Lst file in the LAN Dierctory.



Meeting Maker

Meetings for Above & Beyond users can be planned easily. The cost of trying to find 
out when everyone in the group is free is normally quite high, because of the 
amount of time it takes to query each person in the group, have them check their 
schedules, and recheck their schedules for alternate slots. Those steps are 
eliminated with the Meeting Maker because anyone can plan a meeting that is 
conflict-free.    Common blocks of free time will be found and you can pick the best 
one.    Then click on "Send Invitations" and an E-mail meeting notice is sent to all 
prospective attendees.    Each user can then add the meeting to their schedule, or 
reply to the E-mail saying that they can't make it.

To access the Meeting Maker, select Schedules: Arrange a Meeting.    Enter the title 
of the meeting, the location, and the ideal begin and end time for the meeting.    
Next, click on "Choose Attendees".    After you have chosen attendees, click "OK".

From the original Meeting Maker dialog, click on "Find Time".    In this dialog, select 
time and weekday constraints if any.    Next, click on "Search" and the Meeting 
Maker will search for common blocks of free time in the schedules of all required 
attendees.
 
Choose the best time from the Meeting Times box and click "OK".    Lastly, click on 
"Send Invitations" to have an E-mail meeting notice sent to all prospective 
attendees.

For the purpose of telephone or video conference calls between parties in differing 
time zones, Multiple Time Zones are supported.    When this box is checked (in the 
Choose Attendees dialog), the Meeting Maker considers which time zone users are 
in and compensates accordingly.    It should normally not be checked; in case some 
users have not set their timezone or set it incorrectly. In which case they would 
receive incorrect meeting time information.



Alarms and Agents Off

When running in a LAN environment and viewing someone else's schedule, select 
"Alarms and Agents Off" in the Options menu.    This will prevent their alarms and E-
mail notices from popping-up on your screen.    Also, this will insure that their 
Autoexec items will not launch events on your PC.    Your alarms and Autoexec items 
will function normally.

Note: The setting you select for this option on their Above & Beyond schedule 
affects only your viewing of their schedule.    Alarms will still pop-up during their 
Above & Beyond sessions.    This setting is remembered between sessions, so you 
need only issue this command once.



Menu Reference Section

The File Menu
The Edit Menu

Notes
The Select Menu
The Juggle Menu
The View Menu
The Surprise Menu
The Worktools Menu

AutoDial
Timer

The Schedules Menu
Arrange a Meeting

The Options Menu



The File Menu

Reports
Transfer...

Mobile Computing
Archive E-mail            
Import
Export
Save
Save As

Name...
Note File
Data File

Exit
Exit All



File: Reports

Daily Schedule...
Today's Schedule
Viewed Schedule
Range of Schedules

Outlook...
Week
Month
3 Month
Range

Notes...
Open Notes
Viewed Schedule Notes

List...
Priority
Alphabetical
Chronological
Project

Project Report
Standard Report...

Print
Setup

Filter
Page Setup



File: Reports: Today's Schedule

This command will print the current day's schedule.    Note: Fluid items are preceded
by a tilde (~) for easy recognition.



File: Reports: Viewed Schedule

This command will print the schedule currently being viewed on the screen.



File: Reports: Range of Schedules

This command will print a number of schedules between the dates you specify.    You
may also specify the number of days you would like to appear on each sheet of 
paper.



File: Reports: Outlook: Week

This printout includes all schedule items for the current week.    To print an outlook 
for a week other than the current week, select Reports: Outlook: Range



File: Reports: Outlook: Month

This printout includes all highlighted schedule items for the current month.    To print
an outlook for a different month, select Reports: Outlook: Range.



File: Reports: Outlook: 3 Month 

This printout includes all highlighted schedule items for the next 90 days.    To print 
an outlook for a different time period, select Reports: Outlook: Range.



File: Reports: Outlook: Range

Use this command to print an outlook for a period of time other than the current 
week/month.



File: Reports: Notes: Open Notes

This command will print all notes that are currently "open."    There are several ways
to open a note for a selected item:

Click on the toolbar note icon.
Press Ctrl+E
Choose Edit Notes from the Edit menu.
In the Insert/Change item dialog click on the Notes button.

Once a note has been added, it can also be accessed by double clicking on the note 
icon that appears at the extreme left of the schedule item.

To close a note, double click on the control bar in the upper left hand corner of the 
note window.



File: Reports: Notes: Viewed Schedule Notes

This command will print all notes (open or not) on the currently viewed schedule.



File: Reports: List: Priority

This printout includes a list of fluid items ordered by priority.    Select "First Page" to 
print just the highest priority items.    Select "All Pages" to print the entire list.



File: Reports: List: Alphabetical

This printout lists all schedule items sorted alphabetically on the item description.



File: Reports: List: Chronological

This printout includes a list of highlighted items for the next 90 days.



File: Reports: List: Project

This printout includes a list of all projects and their internal number generated by 
Above & Beyond.    This number is also included in the log file so you can see the 
assigned project for each done item.    The Report List will be a handy reference.



File: Reports: Project Report

This command will create a Project Report showing duration totals by project for a 
given date range.    The report is written to a file so it can be viewed in a 
spreadsheet application for custom analysis, formatting and printing.



Standard Report: Print

This command prints the report(s) you have selected in File: Reports: Standard 
Report: Setup.    A shortcut for this command is Ctrl+P, or clicking on the toolbar 
printer icon.



Standard Report: Setup

Use this command to specify which reports will be printed when you click on the 
toolbar printer icon, press Ctrl+P. Portrait/landscape and other report attributes are 
set here.

Notes "Interleaved" indicates that you want the attached note (if any) to be printed 
immediatly following each item description.    Choose "At End" to print all items, 
then all notes.



Report: Filter

Use this dialog to specify that items of certain statuses be included or excluded 
from printouts.



Report: Page Setup
 
Use Page Setup to select from a variety of    page height and width options.    For 
example, for Daytimer's appointment books, use 6.75" by 3.75".    Select "Extra 
Wide Left Margins" when using paper with pre-punched holes along that margin.    
Select "Centered" when using non-standard sized paper in the manual feed slot of 
printers such as Laserjets.

If you choose "Full", the settings from the current printer setup are used.    These are
selected in the Windows Control Panel.



File: Transfer: Mobile Computing

Check-Out will copy your Above & Beyond data files to a floppy (A: or B: drive) for 
using Above & Beyond at another location.

Check-In over-writes the Above & Beyond data files on the PC with the data files 
from the floppy disk.    For this reason, you should not make changes to a schedule 
on the hard disk that is checked-out.    When a checked-out schedule is loaded, a 
message will remind you to Check-In before making changes. 



File: Transfer: Archive E-mail

Archive E-mail moves E-mail messages older than 7 days from the EMAIL\SAVED 
directory to the EMAIL\ARCHIVED directory. Use this command if loading of old E-
mail becomes slow. That is, when clicking on Previous in the View: E-mail dialog.



File: Transfer: Import

Schedule items can be imported from the file IMPORT.TXT into Above & Beyond.    
Each line of the file should be in the following format:

<date>    <begin time>    <duration>    <title>

Use one space (no tabs) between the four parts.    Everything but the title is 
optional.

For the many acceptable formats for date, begin time, duration, and title, refer to 
Inserting Items Into a Schedule.    For date format see Entering Item Date.    For 
begin time format see Begin Time and Floating Fixed.    For duration format see 
Entering Item Duration.    For title format see Entering Item Title.



File: Transfer: Export

Use this command to export a schedule, or range of schedules, to a file entitled 
EXPORT.TXT in the current directory.    To easily view this file select View: Export File.



File: Transfer: Save

Save Data will save current changes to disk.    Since changes are saved in the 
background automatically every ten seconds and when exiting, use of this 
command is not required.



File: Transfer: Save As

This feature allows one to return to using a previous version of Above & Beyond 
after having loaded schedule data into the current version.    Save As will save 
your .Pak file in the format of the previous version of your choice.    After using Save 
As select File: Exit.



File: Name: Note File

This command will display the filename for the note that is attached to the selected 
schedule item.    You may need this information to import the text of a note into a 
non-Windows application.    To copy the text of a note into another Windows 
application, use the Windows Copy and Paste commands: Ctrl+C to copy; Ctrl+V to 
paste. 



File: Name: Data File

This command will display the name of the file where the schedule information is 
stored. This is helpful when you have the schedules of several users active on the 
screen at one time. Using this command, you will be able to verify whose schedule 
you are looking at in cases where the person has not entered their name in the 
banner line.    



File: Exit

This command will save current changes and exit Above & Beyond.



File: Exit All

This command will save current changes and exit all Above & Beyond sessions.



The Edit Menu

Insert Item
Insert Memo
Change Item
Delete Item
Recurring...

Change All Occurrences
Delete All Occurrences

Edit Notes
Send E-mail
Done
Fluid Item
Highlighted
Private
Scheduled
Started
Cut
Copy
Paste
Advanced Commands...

Duplicate Item
Start Item After Last
Append Time & Date Stamp
Item Done Now
Item Done, Fit To Gap
Set Status
Insert Done Item
Handle Interruption



Edit: Insert Item

To add a new item to your schedule, press the Insert key; or double-click on any free
area on the schedule.    A dialog box will appear in which you enter specific 
information about the item.    When you have completed your session in the 
Insert/Change dialog box, select OK and the item will be inserted into the schedule.
 
For more about the Insert/Change dialog box, see Inserting Items into a Schedule.



Edit: Insert Memo

To add a "memo" item to your schedule, press Alt+Insert.    This will bring up the 
"insert" dialog box.    Enter the text of the memo and select "OK".    The item will be 
labeled "memo" and will not conflict with scheduled items; nor will it be calculated 
into the workload by the color utilization calendar.



Edit: Change Item

To change previously entered information for an item, double-click on the item; or, if
the item is already selected, you may simply press Enter.    Make the desired 
changes, then click OK.

Note: If the item changed is a recurring item, this one instance is now an 
"Exception" to the "Standard" recurring definition.    To define a new standard, use 
Edit: Change All Occurrences.



Edit: Change All Occurrences

Use this command to change all occurrences of the selected recurring item.

Note: If you wish to change just one instance of a recurring item, use Edit: Change 
Item.



Edit: Delete Item

To remove the selected item from the schedule, press the Delete key. 
 
If the selected item is a recurring item, only the selected instance will be deleted.    
To remove all occurrences of a recurring item, press Ctrl+Delete.



Edit: Delete All Occurrences

To remove all occurrences of a recurring item, press Ctrl+Delete.



Edit: Notes

There are several methods to attach a note to a schedule item.    If you are in the 
"Insert Item" dialog, click on View Notes in the upper left hand corner of the dialog.   
At any other time, press Ctrl+E or click on the toolbar note icon.    Once a note has 
been created a note icon will appear to the right of the item's description on screen. 
To view or edit the note, double-click on the note icon, or click (once) on the toolbar 
note icon.

Navigating in a note is fast and easy. You can use the keyboard exclusively, or use 
your mouse as well.    To move to the end of a note, use Ctrl+End.    To move to the 
beginning of a note, use Ctrl+Home.    Any areas of text can be selected, cut, copied
and pasted to any other Windows application.    You can also paste text from other 
Windows applications.

If you wish to delete the entire text of a note, select the text and then press 
"Delete".    (To select the entire text, place the cursor at the beginning of the text 
and press "Shift+Ctrl+End").

Time and Date Stamp as well as Word and Character Count is available in the note 
window Edit menu.    If some portion of text is selected, the count will be for the 
selected portion.

"Open" notes many be printed by selecting File: Reports: Notes.    Notes are "open" 
until they are closed by pressing Alt+F4, or by selecting "Close" in the note window 
control menu.    Use View: Browse Notes to automatically open the note window for 
each item as it is selected.    This enables you to move quickly from item to item; 
viewing the notes associated with each item.

Sharing Notes

Sometimes you may wish to share a note between two items. If you duplicate an 
item, the duplicate item references the same note.    This is very convenient for 
many purposes, such as notes in preparation for a phone call. Insert a schedule item
for making the first call, then create a duplicate item and reschedule it for the 
follow-up.    The follow-up call item will automatically reference the notes made in 
preparation for the first call, plus any results that you noted there.

Separate Notes

Normally, each instance of a recurring item will share a common note.    Items 
created using the Edit: Duplicate Item command will also share a common note.    If 
you would like to attach a separate note to either of these type of items, choose 
Separate Notes form the Note window File menu.    This will create a separate note 
for a selected item that previously had a shared note. 

Where Your Notes Are Stored

You may not care to know where your notes are stored, because they are so easily 
accessed from Above & Beyond. But here are the details if it interests you.



Notes are stored in a Notes subdirectory from the directory that contains your data 
(.Pak) file. Each note has a filename created from a 3 letter prefix and 5 digit 
number. The prefix will be the same for each note you create for any given data file.
The note file prefix is generated randomly when a new data file is created. 



Edit: Send E-mail

Use this command to send E-mail to one or more Above & Beyond users across a 
network.

First, enter your message and a descriptive subject.    Next, choose the recipient in 
the To: list.    An additional recipient may be specified in the CC: list.    Click on Send 
and your E-mail will be sent.    The list of users appearing in the To: and CC: list 
boxes is drawn from the file User.Lst which is maintained and viewed in the 
Schedules menu.

If you wish to broadcast your message to more than two users, click on Broadcast.    
In the broadcast dialog, you may choose the users to be included in this mailing.    
For each recipient, you may click on To: or CC: to indicate if the message is "To" 
them or theyre getting a complimentary copy.    When finished click OK and then 
click Send.

To view E-mail that you have sent or recieved, choose View: E-mail.



Edit: Done

To indicate that the selected item has been "done", press the Spacebar.    A done 
item appears with a line through it.    The begin time is set to immediately follow the
end time of the previously done item.    To change the item back to undone, press 
the Spacebar again.

Items on future days cannot be marked done.    Instead, move the item to the day it 
was actually done, and then mark it done.

The following day after all items on a given day have been marked done, the 
schedule is "archived" (written) to a log file.    For more on the log files, see Schedule
Archiving.

See also, the Edit menu commands Item Done Now and Item Done, Fit To Gap.



Edit: Fluid

This command (or Alt+F2) will toggle an item from Fluid to Firm, and vise versa.    
For a brief summary of Fluid items, see the section titled Firm / Fluid.    For an in-
depth discussion of Fluid and Firm items, see the section titled Workload Balancing.



Edit: Floating

Use this command (or Alt+F2) to toggle an item between Fixed and Floating.

For details on Floating / Fixed items see the section on Inserting Items into a 
Schedule.



Edit: Highlighted

This command (or F3) will cause the selected item to be underlined.    Press F3 again
to    remove the underline.

Certain reports include only highlighted items.    For example, the Month Outlook, 
the 3 Month Outlook, and the Chronological List.



Edit: Private

This is a toggle command that will flag or unflag a particular item as "Private".    
Private items can be viewed only if your password is entered.    People using your 
view or modify password will see that there is an item scheduled (and its duration)
but cannot view or modify it.    The shortcut for this command is Alt+F3.

An alternate way to make an item private is to begin the item description with the 
vertical bar character:  |    

For more information on passwords, see Options: Settings: Passwords.



Edit: Scheduled

Use this command (or press F4) to toggle an item from Scheduled to Unscheduled 
and vise versa.    Scheduled items appear in the schedule with a Fixed or Floating 
begin time. Unscheduled items appear without a begin time, above the scheduled 
items, and are not considered in time management operations by the dynamic 
scheduler.



Edit: Started

With this command (Shortcut: F5) the elapsed time of an item in progress can be 
displayed.    The Start Item command will start recording the elapsed time 
associated with the selected item.    The elapsed time along with the duration will be
displayed on the schedule line. It will look like this: (:04/:30).    The first number is 
the actual elapsed time, the second is the originally planned duration. 
 
When the item is marked as done, the total elapsed time will be saved and archived
along with the item.    If you accidentally hit the Spacebar, marking    an item done 
that is not actually done, simply toggle the item to undone (by hitting the Spacebar 
again) and the timing will be restored.
 
If you would like to "restart" a "done" item use the Start Item command again.    The 
"done" item will remain marked as done however a duplicate item will be created 
and started at the current time. With this method you have a record of the two (or 
more) segments of time that the item was worked on. 
 
The Start Item command may also be used to manually launch an EXEC or 
AUTOEXEC item earlier in the day on which it is scheduled.



Edit: Cut

The Cut command (Shortcut: Ctrl+X) deletes the selected item from the schedule. 
The deleted item is placed in a temporary holding area known as the Clipboard. You 
can then move the item to another person's schedule with the Paste command.    
See also Edit: Copy and Edit: Paste.



Edit: Copy

The Copy command (Shortcut: Ctrl+C) copies the selected item to the Clipboard so 
that you may duplicate it elsewhere using the Paste command.    See also Edit: 
Paste.

Note: If Copy (or Cut) is used from the Schedules view, the item's date, time, 
duration and title is copied to the Clipboard.    If Copy (or Cut) is used from the 
Alphabetical Items list, only the item's title is copied.



Edit: Paste

The Paste command (Shortcut: Ctrl+V) inserts the item that is on the Clipboard to 
into the current schedule. In order for the Paste command to be available there 
must be some text which as been placed on the Clipboard via the Cut or Copy 
commands.

Cut, Copy and Paste are intended for use when you wish to place the item into 
someone else's schedule.    To copy an item to a different date on your schedule, use
the Duplicate Item command and then move the duplicate item to the desired date. 
See the section entitled Juggling Items for information on how to move items to a 
desired date.

Note: If Copy (or Cut) was used from the Schedules view, Paste will paste the item 
onto a schedule corresponding to the item's date.    If Copy (or Cut) was used from 
the Alphabetical Items list, you may Paste the item onto any date. 



Edit: Duplicate Item

The Duplicate Item command will insert a duplicate of the selected item into the 
schedule directly below the selected item.    Shortcut: press double-quote (") while in
the schedules view. 



Edit: Start Item After Last

With the "Start Item" command (described above), the start time used is the time at
the moment the command is issued.    With "Start Item After Last" the start time 
used is the time when the last done item was finished.    Use this command when 
you wish to "start" an item and indicate that you actually began working on the 
item immediately after the previously done item. 



Edit: Append Time & Date Stamp

Ctrl+D will append the current time and date to the end of the item title.    This 
feature is available anytime outside of the Insert/Change Item dialog.



Edit: Item Done Now

Use this command to indicate that you just now finished the item.    Item Done Now 
marks the item done and, if on today, sets the begin time so that the item ends at 
the current time.    If the item is on a past day, the begin time is not changed.    The 
shortcut for this command is Ctrl+Spacebar.

Items on future days cannot be marked done.    Instead, move the item to the day it 
was actually done, and then check it off.

See also Edit: Item Done and Edit: Item Done, Fit To Gap



Edit: Item Done, Fit To Gap

Use this command (Shortcut: Shift+Spacebar) to indicate that you just now finished 
the item, and that you began working on it immediately following the previously 
done item.

This command adjusts the begin and end time of the selected item so that the item 
fills the available time slot between the previous item and the item following.    In 
other words, the begin time is set to follow the end time of the previous item; and 
the end time is set to the begin time of the item following.    This command is useful 
when you wish to show 100% utilization of your time; that is, no unaccounted-for 
time.

In the event that you thought you were done, but then continued working on the 
item, issue the command again.    The duration will be extended to show that the 
item ended at the current time.



Edit: Indicate Attempt

If you attempt a phone call, for example, and the line is busy, press F6. A duplicate 
of the item is created and the original item is marked done and prefixed with the 
word "attempt:."
This is also useful for anything you begin but cannot complete. The time worked so 
far is recorded and you can finish later.



Edit: Set Status

To indicate that a selected schedule item is of a particular status, click on the item 
with the RIGHT mouse button, then click on the status for that item.    Note: If not 
using a mouse, press Ctrl+F3, then select the status.

The last status in the list (the eighth one) is "special".    If a date has at least one 
special status item scheduled, then the date heading will also appear in the special 
status color.

Related topics: Options: Settings: Statuses and File: Standard Report:Filter.



Edit: Insert Done Item

For those times when you want to record something you did that wasn't planned, 
press F10; or choose Edit: Insert a Done Item.    This is a shortcut for inserting an 
item, editing the begin and end times, and marking it done.    Default values for the 
begin and/or end time are used unless they are modified by being over-typed.    The 
default begin time is the end time of the previously done item.    The default end 
time, is the current time.    See also Edit: Item Done Now. 



Edit: Handle Interruption

If you are interrupted while working on a started item, press the Pause key on your 
keyboard. The started item will be paused until the interruption is over. The end 
time will adjust while the interruption proceeds. When the interruption is over, press
OK and the paused item will be resumed.

The interruption dialog is "modeless" which means you can slide it into a corner and
go about work in other windows. Thus you can access information in you schedules 
during the interruption.



The Select Menu

You may select any schedule item by clicking on it.    To quickly select a schedule 
item that begins with a particular letter, simply press that letter key on the 
keyboard and the schedule will scroll down to the first such item.    To select a 
schedule for a specific date, click on the desired date on the pop-up calendar.

The shortcuts in the Select menu allow you to use keystrokes to select specific 
schedules and schedule items for viewing, editing or juggling.    The shortcuts are 
listed to the right of the commands in the menu.    Shortcuts are to be used instead 
of the pull-down menus;    so don't pull down a menu if you intend to use the 
shortcut keys.

Prior Item
Next Item
Prior Page
Next Page
Top Page
Bottom Page
Today's Schedule
Prior Day
Next Day
Scroll Up
Scroll Down
Prior Week
Next Week
Specific Date
Earliest Undone Schedule
Prior Schedule
Next Schedule
Find
Repeat Find
Earlier Find



Select: Prior Item

This command (shortcut: UP Arrow) selects the item above, or prior to, the item 
currently selected on the schedule.



Select: Next Item

This command (shortcut: DOWN Arrow) selects the item below the item currently 
selected, or the next item on the schedule.



Select: Prior Page

This command (shortcut: Page Up) enables one to view the previous page of a 
schedule that is too long to view on the screen.



Select: Next Page

This command (shortcut: Page Down) enables one to view the previous page of a 
schedule that is too long to view on the screen.



Select: Top Page

This command (shortcut: Ctrl+Home) scrolls the schedule to the top.



Select: Bottom Page

This command (shortcut: Ctrl+end) scrolls the schedule to the bottom.



Select: Today's Schedule

This command (shortcut: HOME) will select the schedule for today.



Select: Prior Day

This command will select the schedule for the day prior to the currently selected 
schedule.    A shortcut for this command    is to press the gray MINUS (-) key near the
numeric keypad.



Select: Next Day

This command will select the schedule for the day after the currently selected 
schedule.    A shortcut for this command is to press the gray PLUS (+) key near the 
numeric keypad. 



Select: Scroll Up

This command (shortcut: Ctrl+Page Up) scrolls the schedule up one page.



Select: Scroll Down

This command (shortcut: Ctrl+Page Down) scrolls the schedule down one page.



Select: Prior Week

The Prior Week command will select the schedule for the day one week prior to the 
currently selected schedule.    A shortcut for this command    is to press F7.



Select: Next Week

The Next Week command will select the schedule for the day one week after the 
currently selected schedule.    A shortcut for this command is to press F8.



Select: Specific Date

To specify the date of the schedule you want to view, press F9. You may also click on
the desired date on the pop-up calendar.

See Entering Item Date for shortcuts on entering dates in Above & Beyond.



Select: Earliest Undone Schedule

The Earliest Undone Schedule command will select the earliest schedule of 
uncompleted items that exists in Above & Beyond.    Archived schedules will not be 
selected.      A shortcut for this command is to press the END key. Remember that all 
items on a schedule for a past day must be marked as done before that schedule 
will be archived. 



Select: Prior Schedule Window

The Prior Schedule command selects the schedule for the date immediately 
preceding the currently selected schedule.    A shortcut for this command is to    
press the LEFT arrow key.
 
If viewing multiple schedule windows, the Prior Schedule command will select the 
schedule that appears to the left of the currently selected schedule.    If the left-most
schedule is selected, the Prior Schedule command will change the schedule in that 
window to the schedule of the previous day.



Select: Next Schedule Window

The Next Schedule command will select the schedule immediately following the 
currently selected schedule.    A shortcut for this command is to press the RIGHT 
arrow key.
 
If you are viewing multiple schedules, the Next Schedule command will select the 
schedule to the right of the currently selected schedule.    If the right-most window 
on the screen has been selected, the Next Schedule command will change the 
schedule in that window to the schedule of the next day.



Select: Find

This command will find a schedule item which contains (or has a note that contains)
a given text sting.      In the Find dialog box, enter the text string as follows:    To 
search item descriptions and memos, type the string in the "Item" line.    To search 
notes, type the string in the "Notes" line.    You may type the same or different 
strings in the Item and Notes lines.    For example you may want to find an item with
"Jones" in the item description or "Project X" in the notes.

Click on OK and the first item with the specified string will be selected.    To find the 
next item with the specified string, choose "Select: Repeat Find".    To search 
backward in time, choose "Select: Earlier Find".



Select: Repeat Find

This command will find the next schedule item with text strings as specified in the 
previous Find command.



Select: Earlier Find

This command will search backward in time for a schedule item with text strings as 
specified in the previous Find command.



The Juggle Menu

The commands in the Juggle menu list the keyboard shortcuts for moving items 
within a schedule or to different schedules. See also Juggling Items. 

Item Position...
Earlier in Day
Later in Day
Prior Schedule
Next Schedule
Prior Week
Next Week

Carry Over Undone Items
Balance Workload
Adjust Workload...

Less/More Workload
Optimize
Priority...

Raise/Lower Fluid Priority
Begin Time...

Earlier/Later Fixed Begin Time
Duration...

Shorter/Longer Duration



Juggle: Earlier in Day

This command (shortcut: Ctrl+Up Arrow) moves the selected item to before the 
item that is above it on the schedule.



Juggle: Later in Day

This command (shortcut: Ctrl+Down Arrow) moves the selected item to after the 
item that appears directly below it on the schedule.



Juggle: Prior Schedule

This command (shortcut Ctrl+Left Arrow) moves the selected item to the previous 
schedule.
 
If you are viewing schedules in multiple windows, the Prior Schedule command will 
transfer the selected item to the schedule on the left.    However, that schedule may 
not necessarily be the prior day.    If you are viewing multiple schedules and the item
you wish to move is in the left-most schedule, then the Prior Schedule command will
cause the schedule in that window will change to the schedule of the preceding day 
and the selected item will appear in that schedule. 



Juggle: Next Schedule

This command (shortcut: Ctrl+right Arrow) moves the selected item to the following
schedule.
 
If you are viewing schedules in multiple windows, the Next Schedule command will 
transfer the selected item to the schedule, or window, to the right.    If you are 
viewing schedules in multiple windows and the item you wish to move is in the 
right-most schedule, then the Next Schedule command will cause the schedule in 
that window to change to the schedule for the next day and the selected item will 
appear in that schedule. 



Juggle: Prior Week

This command (shortcut: Ctrl+F7) moves the selected item back seven days.



Juggle: Next Week

This command (shortcut: Ctrl+F8) moves the selected item ahead seven days.



Juggle: Adjust Workload: Less/More

To increase you workload for today, press Ctrl+M. This brings in one fluid item from 
tomorrow that can be done today. To defer one fluid item until tomorrow, press 
Ctrl+L.



Juggle: Carry Over Undone Items

This command will bring undone items forward to the selected schedule.    
Shortcuts: F12, or click on the suitcase toolbar icon.



Juggle: Balance Workload

Balance Workload (shortcut: Alt+F8) re-schedules all Fluid items dynamically. 
Precedence is given to the items in their order of priority. This means that all things 
being equal, higher priority items will be scheduled earlier than lower priority items.
The priority 1 item may be scheduled today, for example, and the priority 145 item 
may not come up until next month. Each Fluid item has a relative priority from 1 to 
999. 

Balance Workload re-schedules Fluid items based on their priority, duration and the 
available free time.    Fluid items may be moved forward or back (between days), 
again based on priority and the best fit into available free time. The date range 
within which a Fluid item may flow is determined by the "Postpone" and "Deadline" 
dates that you have specified in the Insert/Change item dialog box.    That is, it will 
be scheduled after "Postpone" but before "Deadline".    If an item must occur on a 
particular day (such as Friday) or range of days (such as Monday through Friday), 
these parameters are also taken into consideration.

For an in-depth discussion of Workload Balancing, see the section titled Workload 
Balancing in the Introduction to Above & Beyond.



Juggle: Optimize

Optimize (shortcut:F11) rearranges the items on today's schedule to make the best 
use of your time. It does this by working to eliminate conflicts, taking into account 
the earliest and latest bounds for each item, as well as the priority of fluid items. If 
you have fixed items on your day, the Optimize command is a quick way to 
rearrange floating items on either side of fixed items to make more optimal use of 
time.    Fixed items are not moved.



Juggle: Priority: Raise/Lower Fluid

To quickly make adjustments to an item's priority without going into the change 
screen, these shortcuts can be used: Alt+Up raises the priority by one; Alt+Down 
lowers the priority by one.

If you are in Priority List view, you can also drag the item up to raise its priority, or 
drag the item down to lower it.



Juggle: Begin Time: Earlier/Later Fixed

To quickly make adjustments to an item's begin time without going into the change 
screen, these shortcuts can be used: Alt+Up subtracts five minutes from the begin 
time; Alt+Down adds five minutes.



Juggle: Duration: Shorter/Longer

To quickly make adjustments to an item's duration without going into the 
Insert/Change dialog box, these shortcuts can be used: Alt+Left subtracts five 
minutes from the duration; Alt+Right adds five minutes.



The View Menu

The options in the View menu allow you to choose how you would like to view your 
schedules: in a single window, in multiple windows or as an alphabetical list.    Check
marks to the left of the options in the    menu show which options are currently in 
effect.

Single Window
Projects
Alphabetical List
Priority List
Week at a Glance
Month at a Glance
E-mail
Define Week at a Glance
Tiling...

Horizontal
Vertical
Quad

Special



View: Single Schedule Window

Use this command (or press Ctrl+S) to display one schedule at a time.



View: Projects

Schedule items can be assigned to user defined Projects. A color cube to the left of 
each item indicates its project. To assign an item to a project, simply click on the 
cube and select the project from the list-box.

For an on-screen project summary for the viewed schedule, choose View: 
Special:Tally Project or press Ctrl+Y.    See also, File: Reports: Project Report.

To set up Projects, choose View:Projects. Press Insert to add a new project to the list.
Type in the project name, and set the color for the project indicator. You may also 
enter notes related to each project. The Projects are listed alphabetically. Since the 
first project will be the default for new items, you may wish to force the most 
frequently used project to the top of the list by prefixing its name with a hyphen.    If 
you want the default project to be none, create a project named -none.

If you are using the project feature to set up account codes, you'll save time with a 
special feature of the Edit:Duplicate command. If the project you're duplicating has 
a number embedded in the text, it will be incremented by 1 in the duplicate. 
Remember to use leading 0's to effect proper alphabetizing in numerical order. For 
example, if you duplicate a project named "Account 005", the duplicate will be 
"Account 006". In this way, you can generate a large number of project codes 
quickly.



View: Alphabetical Items List

Use this command (or press Ctrl+A) to display a list of all unarchived items in 
alphabetical order.    Use this list to find an item if you have forgotten where it is in 
your schedule. 



View: Priority List

Use this command (or press Ctrl+R) to display a list of all "Fluid" items ordered by 
priority.    Priority is set in the "Flow" area in the Insert/Change dialog box.    For 
more, see Fluid Items.

Note: The number (surrounded by periods) to the right of the item is the number of 
days ago the item was created.



View: Week at a Glance

Use this command (or press Ctrl+W) to display a week of schedules top to bottom 
(or side to side) on the screen.    To specify how many (up to 7) and which days of 
the week you would like to appear, use View: Define Week at a Glance.    To specify 
top to bottom or side to side select View: Vertical or View: Horizontal.    The default 
view is called Quad tiling.



View: Month at a Glance

Use this command (or press Ctrl+T) to display a 4-week calendar containing 
highlighted items for each day.    For information on highlighted items see Edit: 
Highlight Item. You can move backward or forward in time in jumps of one or four 
weeks.

You can scroll the view a week or month at a time in the following ways:

1:    Use the mouse on the vertical scroll bar,
2:    Press the UP or DOWN arrow keys, or
3:    Press the Page UP or Page DOWN keys.

Here is a tip on how to make the best use of the relatively small Month at a Glance 
boxes: Let the first three or four words of your item description be a concise 
abbreviation.    Use a "Ctrl+Enter" after this abbreviation; then type in the detailed 
description of the item.    Above & Beyond will then display just the abbreviated 
summary in the Month at a Glance boxes.    The summary will be followed by ellipses
to indicate that there is more to the item description.



View: E-Mail

Use this command to view new or old (previously viewed) E-mail.    For new E-mail, 
the oldest message is shown first.    Click on Next for the next (newer) message.    
For each message you have the option of replying by clicking on Reply.    You also 
have the option of adding the message to your schedule by clicking on Schedule. 
When all new E-mail has been viewed, Next will close the E-mail dialog.

For old E-mail, the newest message is shown first.    Click on Previous for the next 
(older) message.    You may also reply to, or schedule old E-mail messages.    E-mail 
you have sent is also saved and will appear in chronological order among old 
received E-mail.

For details on sending E-mail, see Edit: Send E-mail in the Menu Reference Section.   
See also, File:Transfer: Archive E-mail.



View: Define Week at a Glance

Use this command to specify which days of the week will appear simultaneously 
when you issue the Week at a Glance command.



View: Horizontal Tiling

With Horizontal Tiling, when more than one schedule is simultaneously displayed 
(Multiple Windows or Week-at-a-Glance), schedules are tiled side by side, across the
screen. 



View: Vertical Tiling

With Vertical Tiling, when more than one schedule is simultaneously displayed 
(Multiple Windows or Week-at-a-Glance), schedules are tiled, one above the other, 
on the screen. 



View: Quad Tiling

With Quad Tiling, when more than one schedule is simultaneously displayed 
(Multiple Windows or Week-at-a-Glance), four windows are tiled in quadrants.



View: Special

Immediate Focus
Time Graph
Present Filter Priority List
Multiple Schedule Windows
Hide Done Items
Browse Notes
Item Text in Full
Tally Project
History for Month
Item Creation Date
Export File



View: Immediate Focus

Use "Immediate Focus" for those times when you want to glance at your schedule 
and get a handle on what's to do now, and you don't want to be distracted by the 
vast number of items later in the day. This command cuts your display to just the 
next 7 items on today's schedule. Shortcut: press the Backspace key.

To go out of Immediate Focus mode, press the Backspace key again. Confirmation 
will show in the caption, much like it does with Hide Done Items.



View: Time Graph

This two dimensional graph shows fixed items in red and floating items in yellow.    
The time range shown is that set in Options: Set New Item Defaults.    The date 
range shown can be scrolled with the scroll bar.    To return to today, simply click 
anyhere in the time column.

Double clicking on an item brings up the edit dialog box for that item.    Double 
clicking on a blank area brings up the dialog box for inserting a new item at that 
time and date.

Note: The font used in the time graph is specified in File: Choose Fonts: Screen: 
Multiple-View Text.



View: Present Filter Priority List

This view give you a filtered Priority list showing only the fluid items that you can do
now, based on your restrictions of weekdays and time range for each item. Simply 
press Ctrl+F or choose View:Special:Present Filter Priority List.



View: Multiple Schedule Windows

Use this command to designate the number of schedules (2-7) that you would like 
to view at one time.    Unlike Week-at-a-Glance which displays schedules for a 
chronological series of days, this view enables you to display schedules for any 
dates, in any order.



View: Hide Done Items

Use this command to have only undone items displayed.



View: Browse Notes

In Browse Notes mode, the note for the currently selected schedule item is 
displayed automatically. The only "open" note will be the one for the currently 
selected item.



View: Item Text in Full

To view the entire item description, press Shift+V, or choose View: Item Text in Full.



View: Tally Project

To see the total time devoted to each project on the viewed schedule, press Ctrl+Y 
or choose View:Special:Tally Project.

The on-screen Tally Project summary also includes totals for "Old items" and "New 
items". Old items are those that were added prior to today's date. New items are 
those that were added today. These totals are helpful is you wish to know how much
of what you did today "chipped away" at that vast iceberg of items to do, and how 
many were "surprises" that you added today.

Each duration shown is broken down into the time for Done items and Undone 
items.    The display format is:    <Done Items>/<Undone Items>



View: History for Month

Use this command to see the archived items for a particular month.    First go to the 
month you are interested in by using the pop-up calendar (or by pressing F9 and 
typing in any date during that month).    Then select View: History for Month.

For information on archiving, see Archiving Schedules.



View: Item Creation Date

To view the date an item was created, press Shift+C, or choose View: Item Create 
Date.



View: Export File

This command is an easy way to view the export file "Export.Txt".



The Surprise Menu

There may be things you do frequently that you cannot plan for, such as receiving a 
phone call. A list of commonly occurring items can be stored in the Surprise menu. 
When one comes up, select it from the menu and it is automatically inserted into 
today's schedule as a done item. This eliminates the need to type the item 
description and duration each time.

To add or delete Surprise menu items choose Surprise: Edit Surprise List. You can, of
course, edit the duration, begin time or any other aspect of the done item once it 
has been inserted from the Surprise menu.



The Worktools Menu

In addition to AutoDial and the pop-up Timer, the worktools menu provides easy 
access to the accessories and applications you use most.    For example, the Above 
& Beyond Notebook, Windows Cardfile, Notepad and Calculator.    You may edit the 
worktools list (worktools.lst) to tailor it to your needs by choosing "Worktools: Edit 
Worktools List".    Here's a sample worktools.lst file:

Phone book <TAB> C:\ab\nb.exe    C:\ab\phone.nbk
Sales leads <TAB> C:\ab\nb.exe    C:\ab\leads.nbk
Project XYZ <TAB> C:\ab\nb.exe    C:\ab\xyz.nbk

The entries before the TAB will appear in the Worktools pull-down menu.    When an 
entry in Worktools is selected, the command line after the TAB will be executed.    
It's important to use one TAB (and no spaces) between these two parts.

In this example, there will be entries for Phone book, Sales leads, and Project XYZ.    
Clicking    on "Phone book" will run the Above & Beyond Notebook (nb.exe) loaded 
with the data from the file "phone.nbk".



AutoDial

If the currently selected item contains a phone number (with hyphens), that number
will appear when AutoDial is selected.    You may make changes to the number 
before dialing.
 
When an item contains more than one phone number, you can indicate which one 
to dial by selecting it before clicking AutoDial.    If there is no phone number in the 
item description, simply type in the phone number to be dialed.    To dial the 
number, select Local, Distance or International.

AutoDial Settings

Fill in your local area code so that it will not be dialed when calling numbers within 
this area code.

If you need to dial 9 for an outside line, specify "9," in Outside Line Prefix.    The 
comma instructs Autodial to wait two seconds for the outside dial tone before 
proceeding.

Select the serial (Com) port that your modem is using.    Select Tone or Pulse 
depending on the type of phone service you have.    To save the settings without 
dialing a number, click OK.



Timer

With the pop-up Timer, you can easily time phone calls, meetings, or any other 
item. The Rate feature enables you to associate a value with the elapsed time (e.g. 
the cost of a telephone call or the charge for a consultation.) 
 
To activate the timer, click on Timer in the main menu bar, or press Alt+T (when the
main window has the focus).    When the Timer window comes up, its title bar will be
colored to indicate that the timer window currently has the focus (i.e. commands 
and keystrokes will be directed to    this    window).    
 
Looking at the timer window, you can see that there is a Rate box, option buttons 
for "/Minute" and "/Hour", and Start, Stop and Reset buttons. Along the bottom of 
the window, are three number groups. The leftmost number is the current time of 
day. The middle number is the monetary value of the elapsed time based on the 
rate. The rightmost number is the actual elapsed time. 

Timer: Start, Stop, Reset
Timer: The Rate Feature
Timer: Focus To & From
Timer: Moving



Timer: Start, Stop, Reset

To start the timer, click on the Start button, or press Alt+S (when the timer window 
has the focus). 

To stop the timer, click on the Stop button, or press Alt+P.    The timer can be 
stopped, then started again without having to be reset and it start counting from 
the previously accumulated time and value. 

To stop the timer and reset the elapsed time and accumulated value to zero, click 
on the Reset button, or press Alt+E. If this is done accidentally, simply Reset again 
and the time and value figures are recalled.    



Timer: The Rate Feature

When entering the desired rate, up to six digits can be used plus a decimal point 
(period) to separate dollars from cents.    Values can accumulate up to 100,000. 
 
When the rate value is entered, click on (or press the TAB key to move the cursor 
over to) the Minute/Hour option buttons. Use the UP and DOWN arrow keys to select
either the /Minute (per minute) or the /Hour (per hour) option.    Or you can press 
Alt+M to select /Minute or Alt+H to select /Hour. 



Timer: Switch To and From

The simplest way to move the focus from one window to another is to click with a 
mouse anywhere inside the desired window. You can also move the focus from the 
main window to the Timer with Alt+T. 



Timer: Moving

You may position (drag) the timer to any desired location on the screen.



The Schedules Menu

Use the schedules menu to quickly switch between the schedules of workgroup 
members.    To view the schedule of a user, simply click on their name.

The schedules list is divided into two sections.    The upper section lists the users 
who are currently "open".    The lower section lists the users who are not open.    
Clicking on a non-open user (in the lower section) will bring up their schedule, and 
add them to the "open" list in the upper section.

Adding Users to the Schedules Menu

Use the Edit Schedules List command to add users to the list (User.Lst) of network 
users displayed in the lower section.    The following is a sample User.Lst:

Robert <TAB> C:\Robert
Christy <TAB> J:\Christy

"Robert" and "Christy" will appear in the schedules list; and when selected, Above &
Beyond will look for the schedule in the file specified following the TAB.

For    convenience in bringing up several schedules at once, you may include more 
than one datapath:

Managers    <TAB>    C:\Robert    J:\Christy    P:\John

When more than one datapath is specified as above, only the password for the first 
".pak" file will be asked for.    Remember that if passwords have not been set, when 
prompted simply press Enter to proceed.

Creating a New .Pak File

If you wish to create a new .PAK file, first add a line as above to User.Lst indicating 
where you'd like the .PAK file to be.    Then, in the Schedules menu, select the new 
entry.    A message "File not found. Create?" will appear.    Answer "Yes" and the 
new .PAK file will be created.    When the new schedule is brought up, it will be 
"unnamed" until it is named using "Options: Enter Name".    Note: The name entered
with the "Enter Name" command    does not affect the name of the .PAK file.    The 
name of the .PAK file of the currently open schedule can be seen by selecting 
"File:Name: Data File".

Arrange a Meeting

For details, see the The Meeting Maker in the section entitled "Workgroup Use". 

Set LAN Directory



See Set LAN Directory in the Workgroup Use section.



The Options Menu

Delete Sample Items
Calendar
Settings
Time Values
Copy Above & Beyond for a Friend to Try
Enter Name
Order an Above & Beyond License
Order an Above & Beyond Upgrade
Enter User ID
Alarms and Agents Off
World Timeline
Conflict Checking On
Display Seconds in CaptionToolbar Off
Clock Off
Log Files Off



Options: Settings

New Item Defaults
Colors
Fonts
Statuses
Workload Balancing
Alarm Sound
Passwords
Time Zone



Options: Delete Sample Items

The Delete Sample Items command will remove the sample items from the 
schedules.

If Above & Beyond opens with sample items instead of your data, be sure that the 
path to your .PAK file is specified in your Above & Beyond icon command line.    In 
the Program Manager, select the Above & Beyond icon and choose File:Properties to
view/edit the command line.    Your command line, for example, might be:

C:\AB\A&B.exe G:\Michael\Timedata.Pak



Options: Calendar

With the pop-up calendar you can quickly display the schedule of any date from 
1987 to 2068.    You may also instantly move any schedule item to any date.    To 
open the calendar select Options: Calendar: Open.

Using the calendar and a mouse, selected schedule items may be quickly moved to 
any date.    Click on the item to be moved, then click with the RIGHT mouse button 
on the target date.    The item will be moved to that date.    To view the date, click on
the date with the LEFT mouse button.

Calendar: Moving & Sizing
Calendar: Selecting Months
Calendar: Color Utilization
Calendar: 4-4-5 Quarterly Format



Calendar: Moving & Sizing

You can position (drag) the Calendar to any desired location on the screen.    If it is 
immovable, toggle (off) the Tiled option.

The size and location of the calendar will    normally be saved along with schedule 
changes.    If a size or position change is the only change made however, use the 
File:Save command to retain this information across scheduling sessions.

To manipulate the calendar with the keyboard, the calendar must have the focus.    
You can use the TAB key to switch the focus between the calendar and the main 
schedules window.



Calendar: Selecting Months

To display the previous month on the calendar, you can either press the UP arrow 
key while the calendar has the focus, click on the UP arrow at the top of the 
calendar scroll bar. 
 
To display the next month, either press the DOWN arrow key while the calendar has 
the focus, or click the DOWN arrow at the bottom of the calendar scroll bar. 
    
To view the calendar for the currently displayed month in the prior year, press PAGE 
UP, or click in the gray area in the scroll bar between the UP arrow at the top of the 
calendar scroll bar and the scroll box (the white rectangle in the scroll bar). 
 
To view the calendar for the same month one year ahead, press PAGE DOWN, or 
click in the gray scroll bar area between the scroll box and the DOWN arrow at the 
bottom of the calendar scroll bar. 
 
You can also leap many years forward or backward easily by dragging the calendar 
scroll box up or down within the scroll bar.    The scroll bar represents the entire 
range of possible schedules from April 1986 to December 2068.    You can jump to 
the middle of the calendar range, using a mouse, by dragging the scroll box to the 
middle of the gray area in the calendar scroll bar. 



Calendar: Color Utilization
 
By selecting Color Utilization in the Calendar menu, you can see at a glance, how 
full each of your daily schedules is -- for an entire month.    On the    calendar, each 
day in the month has a background color ranging from green to red; based on the 
percentage of utilization.    Pure green indicates a day that is 0% scheduled.    Pure 
yellow indicates a day that is 50% scheduled.    Pure orange indicates 75%.    Pure 
red indicates 100% utilization.
 
Days in the past which have been archived and current or future days which have 
no items or items whose total duration is zero appear gray.    The utilization is based 
on the time remaining today, and the length of your day as specified in "Options:Set
New Item Defaults". 



Calendar: 4-4-5 Quarterly Format

With this option selected, Month at a Glance, the pop-up Calendar, and the 
Extended Outlook (13 week printout) will appear in 4-4-5 format.

For more information on the 4-4-5 format, please see the section titled 4-4-5 
Quarterly Calendar.



Settings: New Item Defaults

Use this dialog to specify the default duration and time bounds that will appear 
when the Insert/Change dialog box is displayed for a new item.

For "Duration", enter the amount of time you wish to appear as the default duration 
for your scheduled items.    Use "Earliest" and "Latest" to specify your normal 
working day.    Floating items will be scheduled between these times.    Note: By 
specifying the bounds here rather than individually for each item, you are then able 
to later "globally" re-adjust the bounds of all "floating" items by simply changing the
values shown in this setting.



Settings: Colors

Fluid items and Unscheduled items can be set to appear in a special color which you
specify here.    In addition, you may choose a special background color for done 
items.



Settings: Fonts

You can select different fonts for viewing on screen and for printouts.

For printouts you can choose different fonts for "Normal text", "Headings" and 
"Extended Outlook".    Extended Outlook refers to reports such as the Week and 
Month Outlooks.

For on screen, you can choose different fonts for when schedules are displayed in a 
Single Schedule Window, and when displayed in Multiple Schedule Windows such as
Week-at-a- Glance.    In addition, you may select a special font for Month-at-a-Glance
text.



Settings: Statuses

Use this dialog to define up to eight statuses for schedule items.    Initially, six 
default statuses are shown.    These may be changed to suit your purposes.    Items 
of a particular status will appear in the color shown by the "Color Sample Text".    To 
change the colors of a status, click on "Set", click on a desired color in the "Basic 
Color" area, then click on OK.    Note: For comparison while choosing colors, the 
existing status colors are shown in the "Custom Color" area.

Windows will only use solid colors for text. If your selection is not a solid color, the 
nearest solid color will be used. To preview how your selection will actually appear, 
see the color sample rectangle that's labeled "Solid Color." 

To indicate that a selected schedule item is of a particular status, click on the item 
with the RIGHT mouse button, then click on the status for that item.    Note: If not 
using a mouse, press Ctrl+F3, then select the status.

The last status in the list (the eighth one) is "special".    If a date has at least one 
special status item scheduled, then the date heading will also appear in the special 
status color.

Related topics: Edit: Set Status and File: Standard Report: Filter.



Settings: Workload Balancing

Use this dialog to specify that a certain amount of free time be allocated on today 
and/or future days to allow for the unexpected.    If no Free Reserve is specified, the 
Balance Workload will completely fill your working day with scheduled items.

Your working day is determined from the "Earliest" and "Latest" times in Settings: 
New Item Defaults.    On today, as the amount of time left in your working day 
decreases, the amount of free reserve allocated will be also be reduced accordingly.

In Keep Clear you may specify a date range to be kept clear of all fluid items. Use 
this, for example, when going on vacation.



Settings: Alarm Sound

With a Windows sound driver installed, your may choose from a list of .WAV files.    
Without a sound driver, your choices are: the default, or no sound.



Settings: Passwords

A password may be set to restrict the viewing and/or modifying of your schedules 
by others.

Specify your password in Your password.    Use "Your password for total access 
including    setting passwords and viewing Private items.    If it is left blank, anyone 
will have unlimited access.    For more information on Private items, see Edit: Private
Item in the Menu Reference Section.

To allow certain people to view your schedule, enter an "Others View password and 
give this password to them.    If they do not enter the password the schedules will 
appear blank.
To allow certain people to view or modify your schedule, enter an Others Modify 
password and give it to them.

If you have a password set, but don't want to have to enter your password each 
time you start Above & Beyond, you can add p=<your password> to the end of the 
Above & Beyond icon command line.    For example, c:\ab\a&b.exe c:\steve    
p=m59b3



Settings: Time Zone

This is where you specify your time zone and the dates for daylight savings.



Options: Time Values

Use this feature to compute the dollar value of the time Above & Beyond    will save 
you!    Simply enter the amount of time you estimate that Above & Beyond will save 
you per day.    Then enter the value (per hour) of your time.    Click on Compute and 
see how much Above & Beyond is really worth!



Options: Copy Above & Beyond for a Friend to Try

Simply put a disk in your drive and select this command.

Note: Distribution of Above & Beyond is encouraged.    For more on this topic see 
Share the Benefits.    



Options: Enter Name

Selecting the Enter Name command will cause a small dialog box to be displayed.    
Type your name in the text box as you would like it to appear on printed schedules 
and in the Above & Beyond title bar. 



Options: Order an Above & Beyond License

Use this dialog to become a registered user.    Please enter all the information 
including how you were introduced to this program.    To print the order form, click 
Print.



Options: Order an Above & Beyond Upgrade

This option is available only to registered users of a previous release. When a major 
upgrade is released, registered users of the previous version can purchase a license 
for the new version at a much lower price. 



Options: Enter User ID

When you receive your user ID from 1Soft in response to your registration, select 
Options: Enter User ID.    Type your user ID into the text box that appears. The word 
"VALID" should appear. 
 
If "VALID" does not appear, check the name that appears in the Above & Beyond 
title bar.    The name should match exactly the name appearing on the letter with 
your user ID.    If it is not the same, correct it using the Enter Name command. 



Options: Alarms and Agents Off

This option will suppress all alarms and agents (Exec and Autoexec launching).    
This is helpful in a LAN environment when viewing someone else's schedule.    For 
more, see Alarms and Agents Off in the Workgroup Use section.

Note: To test the alarm sound, toggle this option off, then on again.



Options: World Timeline

A world timeline can be displayed at the bottom of the screen showing the current 
time at six world-wide time zones. The cities shown are the first six cities listed in 
the file TimeZone.Lst. To display different cities, edit TimeZone.Lst accordingly. If 
you simply wish to replace a displayed city with another city in the same time zone, 
you may do that in Options:Settings:Time Zone. Select the city to change in the list 
box and overtype the name with the city you prefer.



Options: Conflict Checking On

With "Conflict Checking On" you will be alerted when attempting to schedule an 
item for a time period where there is already an item scheduled.    Above & Beyond 
will check for conflicts for one year into the future.    If a conflict is found, it will give 
you a warning message.



Options: Display Seconds in Caption

Set this option to have the current time displayed in hours, minutes and seconds.    
Note: The "caption" is the line below the toolbar.



Options: Toolbar Off

Select this option to remove the toolbar from view.    Select it again to restore the 
toolbar.    For more information on the toolbar, see Toolbar.



Options: Clock Off

When Above & Beyond is running, a small digital clock is displayed in the lower right
hand corner of the screen.    To switch back to Above & Beyond from another 
application, simply click once on the clock.    Select Options: Clock Off to remove the
clock from view.

The clock colors may be set in the Windows Control Panel which can be easily 
accessed from the File menu in Above & Beyond. The background used is the color 
setting for Active Title Bar. The color setting for Active Title Bar Text is used for the 
digits.      

To move the location of the clock, click the left mouse button down, drag it to 
another location, and release the button.



Options: Log Files Off

Select this option if you do not wish to have Above & Beyond maintain monthly log 
files of all done items.    For information on log files, see Schedule Archiving.

Log Files are optional because you can easily go back in time (in Above & Beyond) 
to see what was accomplished.



Technical Support

Over the Internet, E-mail to: 71240.1625@compuserve.com.    Visit our web-site 
at http://www.1soft.com for program updates and answers to frequently asked 
questions.

On Compuserve, E-mail to 71240,1625.    To post a public question or comment 
that other Above & Beyond users can see and respond to, E-mail to 71240,1625 
from within the WinBiz forum, section 8 (PIMS).    You may download updates to 
Above & Beyond from WinBiz, library 8.

Fax anytime to (541) 822-3300. Telephone technical support is available at (541) 
822-6000 during the hours listed below for your time zone:

Pacific U.S.: 8am - 4pm Mon - Fri
 

Mountain U.S.: 9am - 5pm Mon - Fri

Central U.S.: 10am - 6pm Mon - Fri
 
Eastern U.S.:11am - 7pm Mon - Fri

U K: 4pm - Mid. Mon - Fri

W. Europe: 5pm - 1am Mon - Fri

Sydney, Aus.: 2am - 10am Tue - Sat

Hawaii: 6am - 2pm Mon - Fri




